Digital Still Camera

Cyber-shot Handbook

DSC-S650/S700

Before operating the unit, please read this Handbook and "Instruction Manual" thoroughly, and retain it for future reference.
Notes on using your camera

Types of “Memory Stick” that can be used (not supplied)

The IC recording medium used by this camera is a “Memory Stick Duo”. There are two types of “Memory Stick”.

“Memory Stick Duo”: you can use a “Memory Stick Duo” with your camera.

“Memory Stick”: you cannot use a “Memory Stick” with your camera.

Other memory cards cannot be used.

- For details on “Memory Stick Duo”, see page 96.

When using a “Memory Stick Duo” with “Memory Stick” compatible equipment

You can use the “Memory Stick Duo” by inserting it into the Memory Stick Duo Adaptor (not supplied).

Notes on the LCD screen and lens

- The LCD screen is manufactured using extremely high-precision technology so over 99.99% of the pixels are operational for effective use. However, there may be some tiny black points and/or bright points (white, red, blue or green in color) that constantly appear on the LCD screen. These points are normal in the manufacturing process and do not affect the recording in any way.

- Exposing the LCD screen or the lens to direct sunlight for long periods may cause malfunctions. Be careful when placing the camera near a window or outdoors.

- Do not press against the LCD screen. The screen may be discolored and that may cause a malfunction.

- Images may trail across on the LCD screen in a cold location. This is not a malfunction.

- This camera is equipped with a power zoom lens. Be careful not to bump the lens, and be careful not to apply force to it.

The pictures used in this Handbook

The photographs used as examples of pictures in this Handbook are reproduced images, and are not actual images shot using this camera.

On illustrations

Illustrations used in this Handbook are of the DSC-S650 unless noted otherwise.
Table of contents

Notes on using your camera ................................................................. 2
Basic techniques for better images ........................................................ 6
  Focus – Focusing on a subject successfully ........................................... 6
  Exposure – Adjusting the light intensity ................................................. 7
  Color – On the effects of lighting ......................................................... 8
  Quality – On “image quality” and “image size” .................................. 9
Identifying parts .................................................................................. 10
Indicators on the screen ...................................................................... 12
Changing the screen display ................................................................. 16
Using the internal memory ................................................................. 17

Basic Operations

Using the mode dial ............................................................................ 18
Shooting images easily (Auto adjustment mode) .................................. 19
Shooting still images (Scene selection) ................................................. 25
Viewing/deleting images ..................................................................... 28

Using the menu

Using menu items .............................................................................. 30
Menu items ......................................................................................... 31
Shooting menu ................................................................................... 32
  COLOR (Color Mode): Changing the vividness of the image or adding special effects
  (Metering Mode): Selecting the metering mode
  WB (White Bal): Adjusting the color tones
  ISO: Selecting a luminous sensitivity
  (P.Quality): Selecting the still image quality
  Mode (REC Mode): Selecting the continuous shooting method
  (Flash Level): Adjusting the amount of flash light
  (Sharpness): Adjusting the sharpness of the image
  (Setup): Changing Setup items
Table of contents

Viewing menu ........................................................................................................................................ 39
  🗂️ (Folder): Selecting the folder for viewing images
  🛑 (Protect): Preventing accidental erasure
  📷 DPOF: Adding a Print order mark
  📢 (Print): Printing images using a printer
  ⚪ (Slide): Playing back a series of images
  📖 (Resize): Changing the image size of a recorded image
  🔄 (Rotate): Rotating a still image
  🛠️ (Setup): Changing Setup items

Using the Setup screen

Using Setup items ....................................................................................................................................... 45
  📷 Camera ........................................................................................................................................ 46
    Digital Zoom                                             Red Eye Reduction
    Function Guide                                          Auto Review
  📜 Internal Memory Tool ................................................. 48
    Format
  🖼 Memory Stick Tool ......................................................... 49
    Format                                                  Change REC. Folder
    Create REC. Folder                                     Copy
  📤 Setup 1 ........................................................................ 52
    LCD Backlight                                           Language
    Beep                                                    Initialize
  📤 Setup 2 ........................................................................ 53
    File Number                                             Video Out
    USB Connect                                             Clock Set

Viewing images on a TV screen

Viewing images on a TV screen ............................................................................................................ 55
# Table of contents

## Using your computer
- Enjoying your Windows computer ...........................................................57
- Installing the software (supplied) ............................................................59
- Copying images to your computer ...........................................................60
- Viewing image files stored on a computer with your camera (using a “Memory Stick Duo”) ...........................................................67
- Using the “Picture Motion Browser” (supplied) ........................................68
- Using your Macintosh computer ..............................................................74

## Printing still images
- How to print still images .........................................................................76
- Printing images directly using a PictBridge compliant printer ...............77
- Printing at a shop ..................................................................................81

## Troubleshooting
- Troubleshooting ....................................................................................83
- Warning messages ..................................................................................93

## Others
- To use your camera abroad — Power sources .......................................95
- On the “Memory Stick” ..........................................................................96
- On the batteries .....................................................................................98

## Index
- Index .........................................................................................................99
Basic techniques for better images

Focus

Focus Exposure Color Quality

This section describes the basics so you can enjoy your camera. It tells you how to use various camera functions such as the mode dial (page 18), the menus (page 30), and so on.

Focus

Focusing on a subject successfully

When you press the shutter button halfway down, the camera adjusts the focus automatically (Auto Focus). Remember to press the shutter button only halfway down.

Press the shutter button fully down suddenly.

Press the shutter button halfway down.

AE/AF lock indicator flashing ➔ lit/beeps

Then press the shutter button fully down.

If the image looks blurred even after focusing, it may be because of camera shake. ➔ See “Hints for preventing blur” (as follows).

Hints for preventing blur

Hold the camera steady, keeping your arms at your side. It is recommended to lean against a tree or a building nearby to steady yourself. Shooting with a 2-second delay self-timer or using a tripod is also effective. Use the flash when you shoot under a low light condition.
Basic techniques for better images

**Exposure** Adjusting the light intensity

You can create various images by adjusting the exposure and the ISO sensitivity. Exposure is the amount of light that the camera will receive when you release the shutter.

**Shutter speed** = Length of time the camera receives light

**Aperture** = Size of the opening allowing light to pass through

**ISO sensitivity (Recommended Exposure Index)** = Recording sensitivity

---

**Overexposure**

= too much light

Whitish image

The exposure is automatically set to the proper value in the auto adjustment mode. However, you can adjust it manually using the functions below.

**Correct exposure**

**Underexposure**

= too little light

Darker image

**Adjusting EV:**

Allows you to adjust the exposure determined by the camera (page 23).

**Metering Mode:**

Allows you to change the part of the subject to be measured to determine the exposure (page 33).

---

**ISO sensitivity**

ISO sensitivity is measurement, estimating how much light an image pickup device receives. Even when the exposure is the same, images differ depending on the ISO sensitivity.

To adjust the ISO sensitivity, see page 35.

**High ISO sensitivity**

Records a bright image even when shooting in a dark location. However, the image tends to become noisy.

**Low ISO sensitivity**

Records a smoother image. However, when the exposure is insufficient, the image may become darker.
**Color**

**On the effects of lighting**

The apparent color of the subject is affected by the lighting conditions.

**Example: The color of an image affected by light sources**

<table>
<thead>
<tr>
<th>Weather/lighting</th>
<th>Daylight</th>
<th>Cloudy</th>
<th>Fluorescent</th>
<th>Incandescent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Characteristics</td>
<td>White (standard)</td>
<td>Bluish</td>
<td>Blue-tinged</td>
<td>Reddish</td>
</tr>
<tr>
<td>of light</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The color tones are adjusted automatically in the auto adjustment mode. However, you can adjust color tones manually with [White Bal] (page 34).
Basic techniques for better images

Quality On “image quality” and “image size”

A digital image is made up of a collection of small dots called pixels. If it contains a large number of pixels, the picture becomes large, it takes up more memory, and the image is displayed in fine detail. “Image size” is shown by the number of pixels. Although you cannot see the differences on the screen of the camera, the fine detail and data processing time differ when the image is printed or displayed on a computer screen.

Description of the pixels and the image size

1. Image size: 7M
   3072 pixels × 2304 pixels = 7,077,888 pixels
2. Image size: VGA(E-Mail)
   640 pixels × 480 pixels = 307,200 pixels

Selecting the image size for use (page 24)

Many pixels (Fine image quality and large file size)
Example: Printing in up to A3 size

Few pixels (Rough image quality but small file size)
Example: An attached image to be sent by e-mail

Selecting the image quality (compression ratio) in combination (page 36)

You can select the compression ratio when digital images are saved. When you select a high compression ratio, the image lacks the fineness of detail, but has a smaller file size.
Identifying parts

See the pages in parentheses for details of operation.

1 Shutter button (19)
2 Mode dial (19)
3 Self-timer lamp (22)
4 Lens
5 POWER button
6 POWER lamp
7 Flash (21)
8 Buzzer
9 Microphone
10 • (USB) · A/V OUT terminal (side)

1 (Playback) button (28)
2 LCD screen (16)
3 (Image Size/Delete) button (24, 28)
4 For shooting: Zoom (W/T) button (20)
   For viewing: Q (Playback zoom) button/ (Index) button (28, 29)
5 Hook for wrist strap
6 DISP button (16)
   • Press DISP longer to select the brightness of the LCD backlight.
7 MENU button (30)
   • Press MENU longer to display the (Setup) screen.
8 Control button
   Menu on: △/▽/◀/▶/ ● (30)
   Menu off: / / / (21-23)
9 Access lamp
10 Tripod receptacle (bottom)
   • Use a tripod with a screw length of less than 5.5 mm (7/32 inch). You will be unable to firmly secure the camera to tripods having screws longer than 5.5 mm (7/32 inch), and may damage the camera.
11 Battery/“Memory Stick Duo” cover
Identifying parts

AC adaptor cord cover
When using an AC-LS5K AC Adaptor (not supplied)

- Do not pinch the cord when you close the cover.
- You cannot charge the Nickel-Metal Hydride batteries by the AC-LS5K AC Adaptor. Use the battery charger to charge the Nickel-Metal Hydride batteries.
Indicators on the screen

See the pages in parentheses for details of operation.

When shooting still images

<table>
<thead>
<tr>
<th>Display</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Battery remaining" /></td>
<td>Battery remaining</td>
</tr>
<tr>
<td><img src="image2" alt="AE/AF lock" /></td>
<td>AE/AF lock (19)</td>
</tr>
<tr>
<td><img src="image3" alt="Recording mode" /></td>
<td>Recording mode (19, 37)</td>
</tr>
<tr>
<td><img src="image4" alt="White balance" /></td>
<td>White balance (34)</td>
</tr>
<tr>
<td>STBY REC</td>
<td>Standby/Recording a movie</td>
</tr>
<tr>
<td><img src="image5" alt="Mode dial" /></td>
<td>Mode dial (Scene Selection) (25)</td>
</tr>
<tr>
<td>P</td>
<td>Mode dial (Program Auto) (18)</td>
</tr>
<tr>
<td><img src="image6" alt="Camera mode" /></td>
<td>Camera mode</td>
</tr>
<tr>
<td><img src="image7" alt="Flash mode" /></td>
<td>Flash mode (21)</td>
</tr>
<tr>
<td><img src="image8" alt="Flash charging" /></td>
<td>Flash charging</td>
</tr>
<tr>
<td><img src="image9" alt="Zoom scaling" /></td>
<td>Zoom scaling (20, 46)</td>
</tr>
<tr>
<td><img src="image10" alt="Red-eye reduction" /></td>
<td>Red-eye reduction (47)</td>
</tr>
<tr>
<td><img src="image11" alt="Sharpness" /></td>
<td>Sharpness (38)</td>
</tr>
<tr>
<td><img src="image12" alt="Metering mode" /></td>
<td>Metering mode (33)</td>
</tr>
<tr>
<td><img src="image13" alt="Color mode" /></td>
<td>Color mode (32)</td>
</tr>
</tbody>
</table>

When shooting movies

<table>
<thead>
<tr>
<th>Display</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image14" alt="Macro" /></td>
<td>Macro (21)</td>
</tr>
<tr>
<td><img src="image15" alt="Exposure value scale bar" /></td>
<td>Exposure value scale bar (23)</td>
</tr>
</tbody>
</table>

- The display is changed, depending on the position of the mode dial (shown left).
| Darker | Brighter | Exposure value guide (23) |
### Indicators on the screen

<table>
<thead>
<tr>
<th>Display</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>7M</td>
<td>Image size (24)</td>
</tr>
<tr>
<td>36</td>
<td></td>
</tr>
<tr>
<td>3M</td>
<td>Image quality (36)</td>
</tr>
<tr>
<td>2M</td>
<td></td>
</tr>
<tr>
<td>VGA</td>
<td></td>
</tr>
<tr>
<td>16:9</td>
<td></td>
</tr>
<tr>
<td>4:3</td>
<td></td>
</tr>
<tr>
<td>FINE STD</td>
<td></td>
</tr>
<tr>
<td>➔</td>
<td>Recording folder (49)</td>
</tr>
<tr>
<td>➔</td>
<td>This does not appear when using internal memory.</td>
</tr>
<tr>
<td>➔</td>
<td>Remaining internal memory capacity</td>
</tr>
<tr>
<td>➔</td>
<td>Remaining “Memory Stick” capacity</td>
</tr>
<tr>
<td>00:00:00</td>
<td>Recording time [maximum recordable time]</td>
</tr>
<tr>
<td>00:28:25</td>
<td></td>
</tr>
<tr>
<td>400</td>
<td>Remaining number of recordable images</td>
</tr>
<tr>
<td>➔</td>
<td>Self-timer (22)</td>
</tr>
<tr>
<td>➔</td>
<td>ISO number (35)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Display</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>➔</td>
<td>Vibration warning</td>
</tr>
<tr>
<td>➔</td>
<td>Indicates vibration may prevent you from shooting clear images due to insufficient lighting. Even if the vibration warning appears, you can still shoot images. However, we recommend that you use the flash for better lighting or using a tripod or other means to stabilize the camera (page 6).</td>
</tr>
<tr>
<td>➔</td>
<td>Low battery warning (93)</td>
</tr>
<tr>
<td>➔</td>
<td>Spot metering cross hair (33)</td>
</tr>
<tr>
<td>➔</td>
<td>AF range finder frame</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Display</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>125</td>
<td>Shutter speed</td>
</tr>
<tr>
<td>F2.8</td>
<td>Aperture value</td>
</tr>
<tr>
<td>+2.0EV</td>
<td>Exposure Value (23)</td>
</tr>
<tr>
<td>(not displayed on the screen on the previous page)</td>
<td>Menu (30)</td>
</tr>
</tbody>
</table>
### Indicators on the screen

#### When playing back still images

<table>
<thead>
<tr>
<th>Display</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Battery remaining icon" /></td>
<td>Battery remaining</td>
</tr>
<tr>
<td><img src="image" alt="Recording mode icon" /></td>
<td>Recording mode (19)</td>
</tr>
<tr>
<td><img src="image" alt="Image size icon" /></td>
<td>Image size (24)</td>
</tr>
<tr>
<td><img src="image" alt="Playback mode icon" /></td>
<td>Playback mode</td>
</tr>
<tr>
<td><img src="image" alt="Protect icon" /></td>
<td>Protect (40)</td>
</tr>
<tr>
<td><img src="image" alt="Print order (DPOF) mark icon" /></td>
<td>Print order (DPOF) mark (81)</td>
</tr>
<tr>
<td><img src="image" alt="Change folder icon" /></td>
<td>Change folder (39)</td>
</tr>
<tr>
<td><img src="image" alt="Zoom scaling icon" /></td>
<td>Zoom scaling (28)</td>
</tr>
<tr>
<td><img src="image" alt="Playback icon" /></td>
<td>Playback (28)</td>
</tr>
</tbody>
</table>

#### When playing back movies

<table>
<thead>
<tr>
<th>Display</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Folder-file number icon" /></td>
<td>Folder-file number (39)</td>
</tr>
<tr>
<td><img src="image" alt="Playback bar icon" /></td>
<td>Playback bar</td>
</tr>
</tbody>
</table>
### Indicators on the screen

<table>
<thead>
<tr>
<th>Display</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>![icon]</td>
<td>PictBridge connecting (78)</td>
</tr>
</tbody>
</table>
| ![icon] | Recording folder (49)  
  • This does not appear when using internal memory. |
| ![icon] | Playback folder (39)  
  • This does not appear when using internal memory. |
| ![icon] | Remaining internal memory capacity |
| ![icon] | Remaining “Memory Stick” capacity |
| 8/8 12/12 | Image number/Number of images recorded in selected folder |
| 00:00:12 | Counter |

<table>
<thead>
<tr>
<th>Display</th>
<th>Indication</th>
</tr>
</thead>
</table>
| ![icon] | PictBridge connecting (79)  
  • Do not disconnect the dedicated USB cable while the icon is displayed. |
| +2.0EV | Exposure Value (23) |
| ISO400 | ISO number (35) |
| ![icon] | Metering mode (33) |
| ![icon] | Flash |
| ![icon] | White balance (34) |
| 500 | Shutter speed |
| F2.8 | Aperture value |

<table>
<thead>
<tr>
<th>Display</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>2007 1 1 9:30 AM</td>
<td>Recorded date/time of the playback image</td>
</tr>
<tr>
<td>![icon]</td>
<td>Menu (30)</td>
</tr>
<tr>
<td>![icon] BACK/ NEXT</td>
<td>Select images</td>
</tr>
</tbody>
</table>
Changing the screen display

Each time you press the DISP button, the display changes as follows.

- By pressing DISP button longer, you can increase the LCD backlight.
Using the internal memory

The camera has approximately 24 MB of internal memory. This memory is not removable. Even when there is no “Memory Stick Duo” inserted in the camera, you can record images using this internal memory.

When a “Memory Stick Duo” is inserted
[Recording]: Images are recorded on the “Memory Stick Duo”.
[Playback]: Images on the “Memory Stick Duo” are played back.
[Menu, Setup, etc.]: Various functions can be performed on images on the “Memory Stick Duo”.

When there is no “Memory Stick Duo” inserted
[Recording]: Images are recorded using the internal memory.
[Playback]: Images stored in the internal memory are played back.
[Menu, Setup, etc.]: Various functions can be performed on images in the internal memory.

On image data stored in the internal memory
We recommend that you copy (back up) data without error using one of the following methods.

To copy (back up) data on a “Memory Stick Duo”
Prepare a “Memory Stick Duo” with a capacity of 32 MB or more, then perform the procedure explained in [Copy] (page 51).

To copy (back up) data on a hard disk of your computer
Perform the procedure on pages 60 to 63 without a “Memory Stick Duo” inserted in the camera.

• You cannot copy image data on a “Memory Stick Duo” to the internal memory.
• By connecting the camera and a computer with a dedicated USB cable, you can copy data stored in the internal memory to a computer. However you cannot copy data on a computer to the internal memory.
Set the mode dial to the desired function.

Guide Mark
Set to the desired mode.

Mode dial

Control button

Still image shooting modes

Auto Adjustment mode
Allows easy shooting with the settings adjusted automatically. → page 19

Program Auto mode
Allows you to shoot with the exposure adjusted automatically (both the shutter speed and the aperture value). Also you can select various settings using the menu.
(For details on the functions available → page 31)

Scene Selection mode
Allows you to shoot with preset settings according to the scene. → page 25

On Function Guide
When you press the control button, the descriptions of functions are temporarily displayed (page 47).
Shooting images easily (Auto adjustment mode)

1. Select a mode with the mode dial.
   - Still image (auto adjustment mode): Select 🔴.
   - Movie: Select 🎥.

2. Hold the camera steady, keeping your arm at your side.

   Position the subject in the center of the focus frame.

3. Shoot with the shutter button.
   - Still image:
     ① Press and hold the shutter button halfway down to focus.
     The (AE/AF lock) indicator (green) flashes, a beep sounds, the indicator stops flashing and remains lit.
     ② Press the shutter button fully down.
     The shutter sounds.
   - AE/AF lock indicator
Shooting images easily (Auto adjustment mode)

Movie:
Press the shutter button fully down.
To stop recording, press the shutter button fully down again.

If you shoot a still image of a subject that is difficult to focus on
• The shortest shooting distance is approx. 50 cm (19 3/4 inches). Shoot in the close-up (Macro) mode (page 21) when you shoot a subject closer than the shooting distance.
• When the camera cannot focus on the subject automatically, the AE/AF lock indicator changes to flashing slowly and the beep does not sound. Recompose the shot and focus again.

Subjects difficult to focus on are:
– Distant from the camera and dark
– The contrast between the subject and its background is poor.
– Seen through glass
– Moving fast
– Reflective light or with a lustrous finish
– Flashing
– Backlit

Using the zoom
Press the zoom button.
• When the zoom scale exceeds 3×, the camera uses the Digital Zoom function. For details on the [Digital Zoom] settings and the image quality, see page 46.
• You cannot change the zoom scale while shooting a movie.
Flash (Selecting a flash mode for still images)
Press ▲ (一闪) on the control button repeatedly until the desired mode is selected.

(No indicator): Flash Auto
Strobes when there is insufficient light (default setting)
一闪: Flash forced on
一闪 Slow synchro (Flash forced on)
The shutter speed is slow in a dark place to clearly shoot the background that is out of flash light.
一闪: Flash forced off
- The flash strobos twice. The first time is to adjust the light quantity.
- While charging the flash, 一闪 is displayed.

Macro (Shooting close-up)
Press ◄ (_MACRO) on the control button.
To cancel, press ◄ again.

(No indicator): Macro Off
Macro On (W side: Approx. 5 cm or farther (2 inches or farther), T side: Approx. 35 cm or farther (13 7/8 inches or farther))

Macro
- Setting the zoom all the way to the W side is recommended.
- The in-focus range becomes narrow, and the complete subject may not entirely be in focus.
- The Auto Focus speed drops.
Using the self-timer

Press \( \text{\textgreater\textless} \) on the control button repeatedly until the desired mode is selected.

(No indicator): Not using the self-timer

\( \text{\textgreater\textless} \): Setting the 10-second delay self-timer

\( \text{\textgreater\textless\textgreater} \): Setting the 2-second delay self-timer

Press the shutter button, the self-timer lamp flashes, and a beep sounds until the shutter operates.

To cancel, press \( \text{\textgreater\textless} \) again.

- Use the 2-second delay self-timer to prevent blur of an image made by the shaking of the camera when pressing the shutter button.
EV (Adjusting the exposure manually)

Press ◁ (Ratio) on the control button, then press ▲ (Brighter)/▼ (Darker) to adjust. To turn off the bar displayed, press the ◁ button again.

- For details on the exposure, see page 7.
- The compensation value can be set in 1/3EV increments.
- If a subject is being shot in extremely bright or dark conditions, or the flash is used, the exposure adjustment may not be effective.
To change the still image size

Press (Image Size), and then press ▲/▼ to select the size. For details on the image size, see page 9. The default settings are marked with ✔.

<table>
<thead>
<tr>
<th>Image size</th>
<th>Guidelines</th>
<th>No. of images</th>
<th>Printing</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔ 7M (3072×2304)</td>
<td>Up to A3/11×17&quot; print</td>
<td>Less</td>
<td>Fine</td>
</tr>
<tr>
<td>3:2 1) (3072×2048)</td>
<td>Match 3:2 Aspect Ratio</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5M (2592×1944)</td>
<td>Up to A4/8×10&quot; print</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3M (2048×1536)</td>
<td>Up to 13×18cm /5×7&quot; print</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2M (1632×1224)</td>
<td>Up to 10×15cm /4×6&quot; print</td>
<td>More</td>
<td>Rough</td>
</tr>
<tr>
<td>VGA (640×480)</td>
<td>For E-mail</td>
<td></td>
<td></td>
</tr>
<tr>
<td>16:9 2) (1920×1080)</td>
<td>Display On 16:9 HDTV 3)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1) Images are recorded in 3:2 aspect ratio, same as photograph printing paper or postcards, etc.
2) Both edges of the image may be cut off when printing (page 90).
3) By using a Memory Stick slot or USB connection, you can enjoy images in higher quality.
Shooting still images (Scene selection)

1 Select the desired mode of Scene Selection (\(\text{\ding{118}}, \text{\ding{119}}, \text{\ding{120}}, \text{\ding{121}}, \text{\ding{122}}, \text{\ding{123}}, \text{\ding{124}}\)).
   - For details on modes, see the next page.

2 Shoot with the shutter button.

To cancel the Scene Selection
Set the mode dial to other than the mode of Scene Selection (page 18).
Shooting still images (Scene selection)

Scene Selection modes

The following modes are predetermined to match the scene conditions.

HDR High Sensitivity
Allows you to shoot images without a flash under low light conditions, reducing blur.

Soft Snap
Allows you to shoot skin colors in brighter and warmer tones for more beautiful pictures. In addition, the soft focus effect creates a gentle atmosphere for portraits of people, flowers, etc.

Twilight Portrait*
Suitable for shooting portraits in dark places. Allows you to shoot sharp images of people in dark places without losing the dark atmosphere of the surroundings.

Twilight*
Allows you to shoot night scenes at far distance without losing the dark atmosphere of the surroundings.

Landscape
Focuses only on a distant subject to shoot landscapes, etc.

Beach
When shooting seaside or lakeside scenes, the blue of the water is clearly recorded.

Snow
When shooting snowy scenes or other places where the whole screen appears white, use this mode to prevent sunken colors and record clear images.

*The shutter speed becomes slower, so using a tripod is recommended.
Functions that cannot be combined with Scene Selection

For shooting an image appropriately according to the scene condition, a combination of functions is determined by the camera. Some functions are not available, depending on the Scene Selection mode. When you press the button to select functions that cannot be combined with Scene Selection, a beep sounds.

(✓: you can select the desired setting)

<table>
<thead>
<tr>
<th>Scene Selection Mode</th>
<th>Macro</th>
<th>Flash</th>
<th>White Balance</th>
<th>Burst</th>
<th>Flash level</th>
</tr>
</thead>
<tbody>
<tr>
<td>ISO</td>
<td>✓</td>
<td>✗</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
</tr>
<tr>
<td>Travel</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Night</td>
<td>✓</td>
<td>✗ SL</td>
<td>Auto/ ✗ WB</td>
<td>—</td>
<td>✓</td>
</tr>
<tr>
<td>Landscape</td>
<td>—</td>
<td>✗ SL</td>
<td>✓</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Macro</td>
<td>✓</td>
<td>✗ SL</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Portrait</td>
<td>✓</td>
<td>✗ SL</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Action</td>
<td>✓</td>
<td>✗ SL</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>
Viewing/deleting images

1 Press (Playback) button.
   If you press (Playback) button when the camera is powered off, the camera is turned on in the playback mode. If you press again, switches to recording mode.

2 Select an image with ▲/▼ on the control button.
   Movie:
   Press ● to play back a movie. (Press ● again to stop playback.)
   Press ► to fast forward, press ◀ to rewind. (Press ● to return to normal playback.)
   You cannot listen to the audio with this camera when a movie is played back. To listen to the audio, connect with external outputs such as a TV, a speaker, etc.

■/ □ To delete images
   ① Display the image you want to delete and press ■/ □ (Delete).
   ② Select [Delete] with ▲, then press ●.

To cancel the deletion
   Select [Exit], then press ●.

✵ ✿ To view an enlarged image (playback zoom)
   Press ✿ while displaying a still image.
   To undo the zoom, press ✿.
   Adjust the portion: ▲/▼/◄/►
   Cancel playback zoom: ●
Viewing/deleting images

Viewing an index screen
Press  (Index) and select an image with ▲/▼/◄/►. To display the next (previous) index screen, press ◄►. To return to the single-image screen, press ●.

To delete images in index mode
① While an index screen is displayed, press §/trash (Delete) and select [Select] with ▲/▼ on the control button, then press ●.
② Select the image you want to delete with ▲/▼/◄/►, then press ● to display the ▲ trash (Delete) indicator on the selected image.

Green selection frame

To cancel a selection
Select an image you have previously selected for deletion, then press ● to delete the ▲ trash indicator from the image.

③ Press §/trash (Delete).
④ Select [OK] with ►, then press ●.
⑤ To delete all the images in the folder, select [All In This Folder] with ▲/▼ in step ① instead of [Select], then press ●.
1 **Recording:** Turn on the camera, then set the mode dial.  
**Playback:** Press ➤ (Playback) button.  
Different items are available depending on the position of the mode dial and Recording/Playback mode.

2 **Press MENU to display the menu.**

3 **Select the desired menu item with ◀/▶ on the control button.**
   - If the desired item is invisible, keep pressing ◀/▶ until the item appears on the screen.
   - Press ● after selecting an item in the Playback mode.

4 **Select a setting with ▲/▼.**
   The setting you select is zoomed and set.

5 **Press MENU to turn off the menu.**
   You can also turn off the menu by pressing the shutter button halfway down.

- If there is an item that is not displayed, an ▲/▼ mark appears on the edges of the location where menu items usually appear. To display an item that is not displayed, select the mark with the control button.
- You cannot set items that are not available to select.
Menu items

Menu for shooting (page 32)

The menu items available vary depending on the mode dial position and settings. Only the available items are displayed on the screen.

<table>
<thead>
<tr>
<th>Mode dial position:</th>
<th></th>
<th>P</th>
<th>Scene</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>COLOR (Color Mode)</td>
<td>—</td>
<td>✓</td>
<td>—</td>
<td>✓</td>
</tr>
<tr>
<td>(Metering Mode)</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>WB (White Bal)</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>ISO</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
</tr>
<tr>
<td>(P.Quality)</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
</tr>
<tr>
<td>Mode (REC Mode)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
</tr>
<tr>
<td>(Flash Level)</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>(Sharpness)</td>
<td>—</td>
<td>✓</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>(Setup)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

* The operation is limited according to the Scene mode (page 27).

Menu for viewing (page 39)

* Folder
  DPOF
  (Slide)
  (Rotate)

(Protect)
(Print)
(Resize)
(Setup)

In this “Cyber-shot Handbook”, the available mode dial setting is shown as follows.
The default settings are marked with ✔.

| COLOR (Color Mode): Changing the vividness of the image or adding special effects |
|---------------------------------|---------------------------------|
| B&W (B & W)                     | Sets the image to monochromatic color. |
| Sepia (SEPIA)                   | Sets the image to sepia color. |
| Natural (NATURAL)               | Sets the image to quiet color. |
| Rich (RICH)                     | Sets the image to bright color. |
| ✔ Normal                         | |

- You can select only [Normal], [B&W] or [Sepia] when shooting movies.
**Shooting menu**

For details on the operation ☞ page 30

---

### (Metering Mode): Selecting the metering mode

Selects the metering mode that sets which part of the subject to measure to determine the exposure.

| Spot (Spot metering) (Spot metering) | Measures only a part of the subject.  
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• This function is useful when the subject is backlit or when there is strong contrast between the subject and the background.</td>
</tr>
<tr>
<td><img src="image" alt="Spot metering cross hairs" /></td>
<td><img src="image" alt="Positions on the subject" /></td>
</tr>
</tbody>
</table>

| ☑ Multi (Multi-pattern metering) | Divides into multiple regions and measures each region. The camera determines a well-balanced exposure. |

* For details on the exposure, see page 7.
Adjusts the color tones according to the lighting condition in a situation, for example, when the colors of an image look strange.

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flash (⇌WB)</td>
<td>Adjusts for the flash conditions.</td>
</tr>
<tr>
<td></td>
<td>• You cannot select this item when shooting movies.</td>
</tr>
<tr>
<td>Incandescent (_php)</td>
<td>Adjusts for lightning conditions such as under an incandescent lamp, or bright lighting such as in a photography studio.</td>
</tr>
<tr>
<td>Fluorescent (_php)</td>
<td>Adjusts for fluorescent lighting.</td>
</tr>
<tr>
<td>Cloudy (_php)</td>
<td>Adjusts for a cloudy sky or shaded area.</td>
</tr>
</tbody>
</table>
Using the menu

### Shooting menu

**For details on the operation page 30**

<table>
<thead>
<tr>
<th>Daylight ()){(</th>
<th>Adjusts for a sunny outdoors, shooting evening scenes, night scenes, fireworks, or sunrise, or conditions before and after sundown.</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔ Auto</td>
<td>Adjusts the White Balance automatically.</td>
</tr>
</tbody>
</table>

- For details on the white balance, see page 8.
- Under fluorescent lights that flicker, the white balance function may not work correctly even though you select [Fluorescent] ( ).
- Except in [Flash] ( ) modes, [WB] is set to [Auto] when the flash strobes.
- Some options are not available depending on the Scene mode (page 27).

#### ISO: Selecting a luminous sensitivity

<table>
<thead>
<tr>
<th>ISO</th>
<th>Select a luminous sensitivity with units of ISO. The larger the number, the higher the sensitivity.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1000</td>
<td>Select a large number when shooting in dark locations or shooting a subject moving at high speed, or select a small number to obtain high image quality.</td>
</tr>
<tr>
<td>800</td>
<td></td>
</tr>
<tr>
<td>400</td>
<td></td>
</tr>
<tr>
<td>200</td>
<td></td>
</tr>
<tr>
<td>100</td>
<td></td>
</tr>
<tr>
<td>✔ Auto</td>
<td></td>
</tr>
</tbody>
</table>

- For details on the ISO sensitivity, see page 7.
- Note that the image tends to become noisier as the ISO sensitivity number increases.
- [ISO] is set to [Auto] in the Scene mode.
Selects the still image quality.

<table>
<thead>
<tr>
<th>☑  Fine (FINE)</th>
<th>Records with high quality (low compression).</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><img src="image1" alt="Image of Fine quality" /></td>
</tr>
<tr>
<td></td>
<td>• When the mode dial is (Auto), the quality of a still image is [Fine].</td>
</tr>
<tr>
<td>Standard (STD)</td>
<td>Records with standard quality (high compression).</td>
</tr>
<tr>
<td></td>
<td><img src="image2" alt="Image of Standard quality" /></td>
</tr>
</tbody>
</table>
## Mode (REC Mode): Selecting the continuous shooting method

Selects whether the camera performs continuous shooting or not when you press the shutter button.

| Burst (HDR) | Records three images in succession when you press the shutter button.  
|            | • When “Recording” disappears, you can shoot the next image.  
|            | • The flash is set to ![Flash forced off](image) (Flash forced off).  
| ![Checkmark] Normal | Does not shoot continuously. |

**On the [Burst]**  
- The recording interval is approximately 2 seconds.  
- When the battery level is low, or when the internal memory or “Memory Stick Duo” does not sufficient space, you cannot shoot continuously.  
- You may not be able to shoot images in the Burst mode depending on the Scene mode (page 27).
Adjusts the amount of flash light.

<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>+ (++)</td>
<td>Toward +: Makes the flash level higher.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>✔️ Normal</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>− (−)</td>
<td>Toward −: Makes the flash level lower.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- To change flash mode, see page 21.

Adjusts the sharpness of the image.

<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>+ (++)</td>
<td>Toward +: Sharpens the image.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>✔️ Normal</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>− (−)</td>
<td>Toward −: Softens the image.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

See page 45.
The default settings are marked with ✓.

**Folder**: Selecting the folder for viewing images

Selects the folder containing the image you want to play back when using the camera with “Memory Stick Duo”.

<table>
<thead>
<tr>
<th>OK</th>
<th>See the following procedure.</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓ Cancel</td>
<td>Cancels the selection.</td>
</tr>
</tbody>
</table>

1. Select the desired folder with ◀/▶ on the control button.

2. Select [OK] with ▲, then press ●.

💡 On the folder

The camera stores images in a specified folder of a “Memory Stick Duo”. You can change the folder or create a new one.

- To create a new folder → [Create REC. Folder] (page 49)
- To change the folder for recording images → [Change REC. Folder] (page 50)
- When multiple folders are created in the “Memory Stick Duo” and the first or last image in the folder is displayed, the following indicators appear.
  - : Moves to the previous folder.
  - : Moves to the next folder.
  - : Moves to either the previous or next folders.

Using the menu
Protects images against accidental erasure.

<table>
<thead>
<tr>
<th>Protect (Protect)</th>
<th>See the following procedure.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exit</td>
<td>Exits the Protection function.</td>
</tr>
</tbody>
</table>

**To protect images in single-image mode**

1. Display the image you want to protect.
2. Press MENU to display the menu.
3. Select [Protect (Protect)] with < /> on the control button, then press .
   
   The image is protected and the (protect) indicator appears on the image.

4. To protect other images, select the desired image with < />, then press .

**To protect images in index mode**

1. Press (Index) to display the index screen.
2. Press MENU to display the menu.
3. Select [Protect (Protect)] with < /> on the control button, then press .
4. Select [Select] with ▲ / ▼, then press .
5. Select the image you want to protect with ▲ / ▼ / < /> , then press .
   
   A green (green) indicator appears on the selected image.

6. Repeat step 5 to protect other images.
7. Press MENU.
8. Select [OK] with , then press .

   The (Protect) indicator turns white. The selected images are protected.

- To protect all images in the folder, select [All In This Folder] in step 4, and press . Select [On] with , then press .
To cancel the protection

In single-image mode
Press ● in step ③ or ④ of “To protect images in single-image mode.”

In index mode
① Select the image for which you want to remove protection in step ⑤ of “To protect images in index mode.”
② Press ● to turn the * indicator gray.
③ Repeat the operation above for all images to be unprotected.
④ Press MENU, select [OK] with ▶, and then press ●.

To cancel protection of all images in the folder
Select [All In This Folder] in step ④ of “To protect images in index mode,” and press ●. Select [Off] with ▶, then press ●.
- Note that formatting the internal memory or “Memory Stick Duo” erases all the data stored on the recording media, even if the images are protected, and these images cannot be restored.
- It may take some time to protect an image.

DPOF: Adding a Print order mark

Adds a  (Print order) mark to images you want to print (page 81).

(Print): Printing images using a printer

See page 77.
Plays back recorded images in order (Slide show).

### (Slide): Playing back a series of images

<table>
<thead>
<tr>
<th>Interval</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✅ 3 sec</td>
<td>Sets the slide show interval.</td>
</tr>
<tr>
<td>5 sec</td>
<td></td>
</tr>
<tr>
<td>10 sec</td>
<td></td>
</tr>
<tr>
<td>30 sec</td>
<td></td>
</tr>
<tr>
<td>1 min</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Repeat</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✅ On</td>
<td>Plays back images in a continuous loop.</td>
</tr>
<tr>
<td>Off</td>
<td>After all the images have been played back, the slide show ends.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Image</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✅ Folder</td>
<td>Plays back all the images in the selected folder.</td>
</tr>
<tr>
<td>All</td>
<td>Plays back all the images in a “Memory Stick Duo” in order.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Start</th>
<th>See the following procedure.</th>
</tr>
</thead>
<tbody>
<tr>
<td>✅ Cancel</td>
<td>Cancels the slide show.</td>
</tr>
</tbody>
</table>

1. Select [Interval], [Repeat] and [Image] with ▲▼◄► on the control button.
2. Select [Start] with ▼►, then press ●. The slide show starts.

To end the slide show, press ● pause the slide show. Select [Exit] with ▼, then press ●.

- When pausing during the slide show, you can display the previous/next image with ◀►.

---

For details on the operation page 30
**Using the menu**

*For details on the operation* page 30

**Viewing menu**

### (Resize): Changing the image size of a recorded image

You can change the image size of a recorded image (Resize), and save it as a new file. The original image is retained even after resizing.

<table>
<thead>
<tr>
<th>Size</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>7M</td>
<td>For details on guidelines for selecting the image size, see page 24.</td>
</tr>
<tr>
<td>5M</td>
<td></td>
</tr>
<tr>
<td>3M</td>
<td></td>
</tr>
<tr>
<td>2M</td>
<td></td>
</tr>
<tr>
<td>VGA</td>
<td></td>
</tr>
<tr>
<td>✔️ Cancel</td>
<td>Cancels resizing.</td>
</tr>
</tbody>
</table>

1. Display the image you want to resize.
2. Press MENU to display the menu.
3. Select [ ] (Resize) with ▼/▲ on the control button, then press ●.
4. Select the desired size with ▼/▲, then press ●.
   The resized image is recorded in the recording folder as the newest file.

- For details on Image Size, see page 9.
- You cannot change the size of movies.
- When you change from a small size to a large size, the image quality deteriorates.
- You cannot resize to an image size of 3:2 or 16:9.
- When you resize a 3:2 or 16:9 image, the upper and lower black portions will be displayed on the image.
(Rotate): Rotating a still image

Rotates a still image.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th>Rotates an image. See the following procedure.</th>
</tr>
</thead>
<tbody>
<tr>
<td>OK</td>
<td></td>
<td>Determines the rotation. See the following procedure.</td>
</tr>
<tr>
<td>✓</td>
<td>Cancel</td>
<td>Cancels rotation.</td>
</tr>
</tbody>
</table>

1. Display the image to be rotated.
2. Press MENU to display the menu.
3. Select [ ] (Rotate) with ▲/▼ on the control button, then press ●.
4. Select [ ] with ▲, then rotate the image with ▲/▼.
5. Select [OK] with ▲/▼, then press ●.

- You cannot rotate protected images or movies.
- You may not be able to rotate images shot with other cameras.
- When viewing images on a computer, the image rotation information may not be reflected depending on the software.

(Setup): Changing Setup items

See page 45.
You can change the default settings using the Setup screen.

1. Press MENU to display the menu.

2. After pressing ▶ on the control button, go to the Setup (Setup) setting, then press ▶ again.

3. Press ▲/▼/◄/► on the control button to select the item you want to set.
   The frame of the selected item turns yellow.

4. Press ● to enter the setting.

To turn off the Setup (Setup) screen, press MENU.
To return to the menu from the Setup (Setup) screen, press ◄ on the control button repeatedly.
• Press the shutter button halfway down to close the Setup (Setup) screen and return to the shooting mode.

When the menu is not displayed
Press MENU longer to display the Setup (Setup) screen.

To cancel the Setup (Setup) setting
Select [Cancel] if it appears, then press ● on the control button. If it does not appear, select the previous setting again.
• This setting is maintained even when the power is turned off.
The default settings are marked with ✏️.

**Digital Zoom**

Selects the digital zoom mode. The camera enlarges the image using optical zoom (up to 3×). When the zoom scale exceeds 3×, the camera uses either smart or precision digital zoom.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✏️ Smart (Smart zoom)</td>
<td>Enlarges the image digitally with almost no distortion. This is not available when the image size is set to [7M] or [3:2].</td>
</tr>
<tr>
<td></td>
<td>• The maximum zoom scale of Smart zoom is shown in the following table.</td>
</tr>
<tr>
<td>✕ Precision (Precision digital zoom)</td>
<td>Enlarges all image sizes up to a maximum of 6×, but the image quality deteriorates.</td>
</tr>
<tr>
<td>✕ Off</td>
<td>Does not use the digital zoom.</td>
</tr>
</tbody>
</table>

**Image size and maximum zoom scale using Smart zoom**

<table>
<thead>
<tr>
<th>Size</th>
<th>Maximum zoom scale</th>
</tr>
</thead>
<tbody>
<tr>
<td>5M</td>
<td>Approx. 3.6×</td>
</tr>
<tr>
<td>3M</td>
<td>Approx. 4.5×</td>
</tr>
<tr>
<td>2M</td>
<td>Approx. 5.6×</td>
</tr>
<tr>
<td>VGA</td>
<td>Approx. 14×</td>
</tr>
<tr>
<td>16:9</td>
<td>Approx. 4.8×</td>
</tr>
</tbody>
</table>

• When you press the zoom button, the zoom scaling indicator appears as follows.

• The maximum zoom scale of smart zoom/precision zoom includes the scale of the optical zoom.
• The AF range finder frame does not appear when using the digital zoom.
• When using the smart zoom, the image on the screen may look rough. However, this phenomenon has no effect on the recorded image.
**Function Guide**

When you operate the camera, the description of functions is displayed.

<table>
<thead>
<tr>
<th>On</th>
<th>Displays the function guide.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Does not display the function guide.</td>
</tr>
</tbody>
</table>

**Red Eye Reduction**

Reduces the red-eye phenomenon when using the flash. Select this before shooting.

| On ( ) | Reduces the red-eye phenomenon.  
|-------|-------------------------------|
|       | • The flash pre-strobes twice or more before shooting.  
| Off   | Does not use Red Eye Reduction. |

- Because it takes about a second until the shutter clicks, hold the camera firmly to prevent the effects of vibration. Also, do not let the subject move.
- Red-eye reduction may not produce the desired effects depending on individual differences, the distance to the subject, if the subject does not see the pre-strobe, or other conditions.

**Auto Review**

Displays the recorded image on the screen for approximately two seconds immediately after shooting a still image.

<table>
<thead>
<tr>
<th>On</th>
<th>Use the Auto Review.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Does not use Auto Review.</td>
</tr>
</tbody>
</table>

- If you press the shutter button halfway down during this period, the recorded image display disappears and you can immediately shoot the next image.
This item does not appear when a “Memory Stick Duo” is inserted in the camera.

**Format**

Formats the internal memory.

- Note that formatting irrevocably erases all data in the internal memory, including even protected images.

1. Select [OK] with ▲ on the control button, then press ●.  
   The message “All data in internal memory will be erased Ready?” appears.

2. Select [OK] with ▲, then press ●.  
   The format is complete.

**To cancel the formatting**

Select [Cancel] in step ① or ②, then press ●.
This item appears only when a “Memory Stick Duo” is inserted in the camera.

**Format**

Formats the “Memory Stick Duo”. A commercially available “Memory Stick Duo” is already formatted, and can be used immediately.

- Note that formatting irrevocably erases all data on a “Memory Stick Duo”, including even protected images.

1. Select [OK] with ▲ on the control button, then press ●.
   The message “All data in Memory Stick will be erased Ready?” appears.
2. Select [OK] with ▲, then press ●.
   The format is complete.

**To cancel the formatting**

Select [Cancel] in step ① or ②, then press ●.

**Create REC. Folder**

Creates a folder in a “Memory Stick Duo” for recording images.

1. Select [OK] with ▲ on the control button, then press ●.
   The folder creation screen appears.

2. Select [OK] with ▲, then press ●.
   A new folder is created with a number incremented one higher than the largest number, and the folder becomes the current recording folder.

**To cancel the folder creation**

Select [Cancel] in step ① or ②, then press ●.

- When not creating a new folder, the “101MSDCF” folder is selected as the recording folder.
- You can create folders designated up to “999MSDCF”
- Images are recorded in the newly created folder until a different folder is created or selected.
- You cannot delete a folder with the camera. To delete a folder, use your computer, etc.
- Up to 4,000 images can be stored in one folder. When the folder capacity is exceeded, a new folder is automatically created.
- For details, see “Image file storage destinations and file names” (page 65).
Change REC. Folder

Changes the folder currently used for recording images.

① Select [OK] with ▲ on the control button, then press ●.
   The folder selection screen appears.

② Select the desired folder with ◀/▶, and [OK] with ▲, then press ●.

To cancel changing the recording folder
Select [Cancel] in step ① or ②, then press ●.

- You cannot select the “100MSDCF” folder as a recording folder.
- You cannot move recorded images to a different folder.
Copy

Copies all images in the internal memory to a “Memory Stick Duo”.

1. Insert a “Memory Stick Duo” having 32 MB or larger capacity.
2. Select [OK] with ▲ on the control button, then press ●. The message “All data in internal memory will be copied Ready?” appears.

To cancel the copying
Select [Cancel] in step ② or ③, then press ●.

- Use batteries with enough capacity or the AC Adaptor (not supplied). If you attempt to copy image files using batteries with little remaining charge, the batteries may run out, causing copying to fail or possibly corrupting the data.
- You cannot copy individual images.
- The original images in the internal memory are retained even after copying. To delete the contents of the internal memory, remove the “Memory Stick Duo” after copying, then execute the [Format] command in (Internal Memory Tool) (page 48).
- When you copy the data in the internal Memory to the “Memory Stick Duo”, all the data will be copied. You cannot choose a specific folder on the “Memory Stick Duo” as the destination for the data to be copied.
- Even if you copy data, a (Print order) mark is not copied.
The default settings are marked with ✓.

**LCD Backlight**

Selects the brightness of the LCD backlight when using the camera with batteries.

<table>
<thead>
<tr>
<th>Bright</th>
<th>Brightens</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓ Normal</td>
<td></td>
</tr>
</tbody>
</table>

- You can change the setting by pressing DISP button longer.
- Selecting [Bright] uses up the battery charge faster.

**Beep**

Selects the sound produced when you operate the camera.

<table>
<thead>
<tr>
<th>Shutter</th>
<th>Turns on the shutter sound when you press the shutter button.</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓ On</td>
<td>Turns on the beep/shutter sound when you press the control button/ press the shutter button.</td>
</tr>
<tr>
<td>Off</td>
<td>Turns off the beep/shutter sound.</td>
</tr>
</tbody>
</table>

**Language**

Selects the language to be used to display the menu items, warnings, and messages.

**Initialize**

Initializes the setting to the default setting.

① Select [OK] with ▲ on the control button, then press ●.
   The message “Initialize all settings Ready?” appears.

② Select [OK] with ▲, then press ●.
   The settings are reset to the default setting.

**To cancel the resetting**

Select [Cancel] in step ① or ②, then press ●.

- Make sure that the power is not disconnected during resetting.
The default settings are marked with ✔.

### File Number

Selects the method used to assign file numbers to images.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>✔ Series</td>
<td>Assigns numbers to files in sequence even if the recording</td>
</tr>
<tr>
<td></td>
<td>folder or the “Memory Stick Duo” is changed. (When the</td>
</tr>
<tr>
<td></td>
<td>replaced “Memory Stick Duo” contains a file with a number</td>
</tr>
<tr>
<td></td>
<td>higher than the last assigned number, a number one higher</td>
</tr>
<tr>
<td></td>
<td>than the largest number is assigned.)</td>
</tr>
<tr>
<td>Reset</td>
<td>Starts from 0001 each time the folder is changed. (When the</td>
</tr>
<tr>
<td></td>
<td>recording folder contains a file, a number one higher than the</td>
</tr>
<tr>
<td></td>
<td>largest number is assigned.)</td>
</tr>
</tbody>
</table>

### USB Connect

Selects the USB mode to be used when connecting the camera to a computer or a PictBridge compliant printer using the dedicated USB cable.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>PictBridge</td>
<td>Connects the camera to a PictBridge compliant printer (page 77).</td>
</tr>
<tr>
<td>PTP</td>
<td>When [PTP] (Picture Transfer Protocol) is set and the camera</td>
</tr>
<tr>
<td></td>
<td>is connected to a computer, the images in the recording folder</td>
</tr>
<tr>
<td></td>
<td>on the camera are copied to the computer. (Compatible with</td>
</tr>
<tr>
<td></td>
<td>Windows XP and Mac OS X.)</td>
</tr>
<tr>
<td>✔ Mass Storage</td>
<td>Establishes a Mass Storage connection between the camera and a</td>
</tr>
<tr>
<td></td>
<td>computer or other USB device (page 61).</td>
</tr>
</tbody>
</table>
**Video Out**

Sets the video signal output according to the TV color system of the connected video equipment. Different countries and regions use different TV color systems. If you want to view images on a TV screen, check page 56 for the TV color system of the country or region where the camera is used.

<table>
<thead>
<tr>
<th>NTSC</th>
<th>Sets the video output signal to NTSC mode (e.g., for the USA, Japan).</th>
</tr>
</thead>
<tbody>
<tr>
<td>PAL</td>
<td>Sets the video output signal to PAL mode (e.g., for Europe).</td>
</tr>
</tbody>
</table>

**Clock Set**

Sets the date and time.

1. Select [OK] with ▲ on the control button, then press ●.
2. Select the date display format with ▲/▼, then press ●.
3. Select each item with ◄/► and set the numeric value with ▲/▼, then press ●.
4. Select [OK] with ►, then press ●.

**To cancel the clock setting**

Select [Cancel], then press ●.
You can view images on a TV screen by connecting the camera to a TV.

Turn off both your camera and the TV before connecting the camera and the TV.

1 **Connect the camera to the TV.**

   ![Diagram](image)

- If your TV has stereo input jacks, connect the audio plug (black) of the dedicated A/V cable to the left audio jack.

2 **Turn on the TV and set the TV/video input switch to “video.”**

   • For details, see the operating instructions supplied with the TV.

3 **Press (Playback) button to turn on the camera.**

   ![Diagram](image)

Images shot with the camera appear on the TV screen.

Press ◀▸ on the control button to select the desired image.

• When using your camera abroad, it may be necessary to switch the video signal output to match that of your TV system (page 54).
On TV color systems

If you want to view images on a TV screen, you need a TV with a video input jack and the dedicated A/V cable. The color system of the TV must match that of your digital still camera. Check the following lists for the TV color system of the country or region where the camera is used.

NTSC system
Bahama Islands, Bolivia, Canada, Central America, Chile, Colombia, Ecuador, Jamaica, Japan, Korea, Mexico, Peru, Surinam, Taiwan, the Philippines, the U.S.A., Venezuela, etc.

PAL system
Australia, Austria, Belgium, China, Czech Republic, Denmark, Finland, Germany, Holland, Hong Kong, Hungary, Italy, Kuwait, Malaysia, New Zealand, Norway, Poland, Portugal, Singapore, Slovak Republic, Spain, Sweden, Switzerland, Thailand, United Kingdom, etc.

PAL-M system
Brazil

PAL-N system
Argentina, Paraguay, Uruguay

SECAM system
Bulgaria, France, Guiana, Iran, Iraq, Monaco, Russia, Ukraine, etc.
For details on using a Macintosh computer, refer to “Using your Macintosh computer” (page 74).
This section describes the English version of screen contents.

Install the software (supplied) first (page 59)

Copying images to your computer (page 60)

• Viewing images on your computer

Enjoying images using the “Picture Motion Browser” (page 68)

• Viewing images saved on your computer
• Viewing photos organized by date
• Editing images

• Displaying the shooting locations of still images on maps online. (To do this, your computer needs to be connected to the Internet.)
• Create a new data disc. (CD burner drive or DVD burner drive required.)
• Printing or saving still images with the date inserted.
Enjoying your Windows computer

**Recommended computer environment**

The following environment is recommended for a computer connected to the camera.

**Recommended environment for copying images**

**OS (pre-installed):** Microsoft Windows 2000 Professional, Windows XP Home Edition or Windows XP Professional
- Operation is not assured in an environment based on an upgrade of the operating systems described above or in a multi-boot environment.

**USB jack:** Provided as standard

**Recommended environment for using “Picture Motion Browser”**

**OS (pre-installed):** Microsoft Windows 2000 Professional, Windows XP Home Edition or Windows XP Professional
- Operation is not assured in an environment based on an upgrade of the operating systems described above or in a multi-boot environment.

**Sound card:** 16-bit stereo sound card with speakers

**CPU/Memory:** Pentium III 500 MHz or faster, 128 MB of RAM or more (Recommended: Pentium III 800 MHz or faster and 256 MB of RAM or more)

**Software:** DirectX 9.0c or later

**Hard Disk:** Disk space required for installation—200 MB or more

**Display:** Screen resolution: 1024 × 768 dots or more Colors: High Color (16-bit color) or more
- The software is compatible with DirectX technology. Installation of “DirectX” may be required.

---

**Notes on connecting your camera to a computer**

- Operations are not guaranteed for all the recommended computer environments mentioned above.
- If you connect two or more USB devices to a single computer at the same time, some devices, including your camera, may not operate, depending on the types of USB devices you are using.
- Operations are not guaranteed when using a USB hub.
- There are two modes for a USB connection when connecting a computer. [Mass Storage] (default setting) and [PTP] modes. This section describes [Mass Storage] as an example. For details on [PTP], see page 53.
- When your computer resumes from a suspend or sleep mode, communication between your camera and your computer may not recover at the same time.

---

**Technical Support**

Additional information on this product and answers to frequently asked questions can be found at the Sony Customer Support Website. http://www.sony.net/
Installing the software (supplied)

You can install the software (supplied) using the following procedure.
• When using Windows 2000, do not connect the camera to the computer before installation.
• In Windows 2000/XP, log on as Administrator.

1 Turn on your computer, and insert the CD-ROM (supplied) into the CD-ROM drive.

The installation menu screen appears.

• If it does not appear, double-click (My Computer) ➔ (SONYPICTUTIL).

2 Click [Install].

The “Choose Setup Language” screen appears.

3 Select the desired language, then click [Next].

The [Location Settings] screen appears.

4 Select the [Region] and [Country/Area], then click [Next].

When the [Welcome to the InstallShield Wizard for Sony Picture Utility] appears, click [Next].

The “License Agreement” screen appears.
Read the agreement carefully. If you accept the terms of the agreement, click the radio button next to [I accept the terms of the license agreement] and then click [Next].

5 Follow the instructions on the screen to complete the installation.

• When the restarting confirmation message appears, restart the computer following the instructions on the screen.
• DirectX may be installed depending on system environment of your computer.

6 Remove the CD-ROM after the installation is complete.

After you install the software, a shortcut icon for the customers registration website is created on the desktop.

Once you register on the website, you can get secure and useful customer support. http://www.sony.net/registration/di
Copying images to your computer

This section describes the process using a Windows computer as an example. You can copy images from the camera to your computer as follows.

For a computer with a Memory Stick slot

Remove the “Memory Stick Duo” from the camera and insert it in the Memory Stick Duo Adaptor. Insert the Memory Stick Duo Adaptor in the computer and copy the images.

• Even when you are using Windows 95/98/98 Second Edition/NT/Me, you can copy images by inserting the “Memory Stick Duo” into the Memory Stick slot on your computer.
• If the “Memory Stick PRO Duo” is not recognized, see page 88.

For a computer without a Memory Stick slot

Follow Stages 1 through 4 on pages 60 to 64 to copy images.

• When you are using Windows 2000, install the software (supplied) before proceeding. With Windows XP, installation is unnecessary.
• The screen displays shown in this section are the examples for copying images from “Memory Stick Duo”.

With Windows 95/98/98 Second Edition/NT/Me:

This camera is not compatible with these version of the Windows operating system. When you use a computer without a Memory Stick slot, use a commercially available Memory Stick Reader/Writer to copy images from a “Memory Stick Duo” to your computer.

To copy images in the internal memory to your computer, copy the images to a “Memory Stick Duo” first, then copy them to your computer.
Stage 2: Connecting the camera and your computer

1. To the (USB) - A/V OUT terminal
2. To a USB jack

Dedicated USB cable

Stage 3-A: Copying images to a computer

- With Windows XP, the AutoPlay wizard appears on the desktop.
- “USB Mode Mass Storage” appears on the screen of the camera.
- When a USB connection is established for the first time, your computer automatically runs a program to recognize the camera. Wait for a while.
- During communication, the access indicators turn red. Do not operate the computer until the indicators turn white.
- When the software (supplied) has been installed, the [Import Images] screen (page 69) may be displayed. In this case, you can import images using “Picture Motion Browser” directly.

Stage 3-B: Copying images to a Computer

- For Windows 2000, follow the procedure explained in “Stage 3-B: Copying images to a Computer” on page 63.
- For Windows XP, when the wizard screen does not appear automatically, follow the procedure explained in “Stage 3-B: Copying images to a Computer” on page 63.

This section describes an example of copying images to a “My Documents” folder.
1 After making a USB connection in Stage 2, click [Copy pictures to a folder on my computer using Microsoft Scanner and Camera Wizard] → [OK] as the wizard screen appears automatically on the desktop.

The “Scanner and Camera Wizard” screen appears.

2 Click [Next].

The images saved on the “Memory Stick Duo” of the camera appear.

- If no “Memory Stick Duo” is inserted, images in the internal memory appear.

3 Click the check box of unwanted images to remove the checkmark so they are not copied, then click [Next].

   The “Picture Name and Destination” screen appears.

4 Select a name and destination for the images, then click [Next].

   Image copying starts. When the copying is completed, the “Other Options” screen appears.

   - This section describes an example of copying images to the “My Documents” folder.
Using your computer

5 Click the radio button next to [Nothing. I’m finished working with these pictures] to select it, then click [Next].

The “Completing the Scanner and Camera Wizard” screen appears.

6 Click [Finish].

The wizard screen closes.

- To continue copying other images, disconnect the dedicated USB cable (page 65). Then follow the procedure explained in “Stage 2: Connecting the camera and your computer” on page 61.

Stage 3-B: Copying images to a Computer

- For Windows XP, follow the procedure explained in “Stage 3-A: Copying images to a computer” on page 61.

This section describes an example of copying images to the “My Documents” folder.

1 Double-click [My Computer] → [Removable Disk] → [DCIM].

2 Double-click the folder where the image files you want to copy are stored. Then, right-click an image file to display the menu and click [Copy].

- On the storage destination of the image files, see (page 65).
3 Double-click the [My Documents] folder. Then, right-click on the “My Documents” window to display the menu and click [Paste].

The image files are copied to the “My Documents” folder.

- When an image with the same file name exists in the copy destination folder, the overwrite confirmation message appears. When you overwrite an existing image with a new one, the original file data is deleted. To copy an image file to the computer without overwriting, change the file name to a different name and then copy the image file. However, note that if you change the file name (page 67), you may not be able to play back that image with your camera.

Stage 4: Viewing images on your computer

This section describes the procedure for viewing copied images in the “My Documents” folder.

1 Click [Start] → [My Documents].

The contents of the “My Documents” folder are displayed.

- If you are not using Windows XP, double-click [My Documents] on the desktop.

2 Double-click the desired image file.

The image is displayed.
Using your computer

Copying images to your computer

To delete the USB connection

Perform the procedures listed below beforehand when:
• Disconnecting the dedicated USB cable
• Removing a “Memory Stick Duo”
• Inserting a “Memory Stick Duo” into the camera after copying images from the internal memory
• Turning off the camera

1 Double-click [ ] on the tasktray.

2 Click [ ] (USB Mass Storage Device) → [Stop].

3 Confirm the device on the confirmation window, then click [OK].

4 Click [OK]. The device is disconnected.
   • Step 4 is unnecessary for Windows XP.

Image file storage destinations and file names

The image files recorded with your camera are grouped as folders on the “Memory Stick Duo”.

Example: viewing folders on Windows XP

A Folder containing image data recorded using a camera not equipped with the folder creating function

B Folder containing image data recorded using this camera

When no new folders are created, there are folders as follows:
– “Memory Stick Duo”; “101MSDCF” only
– Internal memory; “101_SONY” only

• You cannot record any images to the “100MSDCF” folder. The images in these folders are available only for viewing.
• You cannot record/playback any images to the “MISC” folder.

Double-click here

Image file storage destinations and file names
• Image files are named as follows. □□□□ stands for any number within the range from 0001 to 9999. The numerical portions of the name of a movie file recorded in movie mode and its corresponding index image file are the same.
  – Still image files: DSC0□□□□.JPG
  – Movie files: MOV0□□□□.AVI
  – Index image files that are recorded when you record movies: MOV0□□□□.THM
• For more information about folders, see pages 39 and 49.
Viewing image files stored on a computer with your camera (using a “Memory Stick Duo”)

This section describes the process using a Windows computer as an example. When an image file copied to a computer no longer remains on a “Memory Stick Duo”, you can view that image again on the camera by copying the image file on the computer to a “Memory Stick Duo”.

- Step 1 is not necessary if the file name set with your camera has not been changed.
- You may be unable to play back some images depending on the image size.
- When an image file has been processed by a computer or when the image file was recorded using a model other than that of your camera, playback on your camera is not guaranteed.
- When there is no folder, create a folder with your camera (page 49) first, and then copy the image file.

1 Right-click the image file, then click [Rename]. Change the file name to “DSC0ssss.”
   Enter a number from 0001 to 9999 for ssss.
   - If the overwrite confirmation message appears, enter a different number.
   - An extension may be displayed depending on the computer settings. The extension for still images is JPG, and the extension for movies is AVI. Do not change the extension.

2 Copy the image file to the “Memory Stick Duo” folder in the following order.
   ① Right-click the image file, then click [Copy].
   ② Double-click [Removable Disk] or [Sony MemoryStick] in [My Computer].
   ③ Right-click the [□□□□MSDCF] folder in the [DCIM] folder, then click [Paste].
      □□□□ stands for any number within the range from 100 to 999.
Using the “Picture Motion Browser” (supplied)

You can use still images and movies from the camera more than ever by taking advantage of the software. This section summarizes the “Picture Motion Browser” and gives the basic instructions.

**“Picture Motion Browser” overview**

With the “Picture Motion Browser” you can:
- Import images shot with the camera and display them on the computer.
- Organize images on the computer on a calendar by shooting date to view them.
- Retouch, print, and send still images as e-mail attachments, change the shooting date, and more.
- Still images can be printed or saved with the date.
- You can create a data disc using a CD burner drive or DVD burner drive.
- For details on the “Picture Motion Browser”, refer to the Help.

To access the Help, click [Start] → [All Programs] (in Windows 2000, [Programs]) → [Sony Picture Utility] → [Help] → [Picture Motion Browser].

**Starting and exiting the “Picture Motion Browser”**

**Starting the “Picture Motion Browser”**

Double-click the 📊 (Picture Motion Browser) icon on the desktop.

Or, from the Start menu: Click [Start] → [All Programs] (in Windows 2000, [Programs]) → [Sony Picture Utility] → [Picture Motion Browser].

**Exiting the “Picture Motion Browser”**

Click ✗ button in the top right corner of the screen.

**Basic instructions**

Follow these steps to import and view images from the camera.

**Importing images**

1. **Make sure “Media Check Tool”* is running.**

   Look for a 📊 (Media Check Tool) icon in the taskbar.

   * “Media Check Tool” is a program that automatically detects and imports images when a “Memory Stick” is inserted or when the camera is connected.

   - If there is no 📊 icon: Click [Start] → [All Programs] (in Windows 2000, [Programs]) → [Sony Picture Utility] → [Tools] → [Media Check Tool].

   - The confirmation message of the Information tool appears on the screen when starting the “Picture Motion Browser” for the first time. Select [Start]. This function informs you of news, such as software updates. You can change the setting later.
Using the “Picture Motion Browser” (supplied)

2 Connect the camera to your computer with the dedicated USB cable.

After the camera is automatically detected, the [Import Images] screen is displayed.

- If you use the Memory Stick slot, refer to page 60 first.
- In Windows XP, if the Auto Play Wizard appears, close it.

3 Import the images.

To start importing images, click the [Import] button.

By default, images are imported into a folder created in “My Pictures” that is named with the date of importing.

- For instructions on changing the “Folder to be imported”, refer to page 72.

Viewing images

1 Checking imported images

When importing is complete, the “Picture Motion Browser” starts. Thumbnails of the imported images are displayed.

- The “My Pictures” folder is set as the default folder in “Viewed folders”.
- You can double-click a thumbnail to display the image by itself.

2 Viewing images in “Viewed folders” arranged by shooting date on a calendar

① Click the [Calendar] tab. Years when images were shot are listed.
② Click the year. Images shot that year are displayed, arranged on the calendar by shooting date.
③ To display images by month, click the desired month. Thumbnails of images shot that month are displayed.
④ To display images by time, click the desired date. Thumbnails of images shot that day are displayed, arranged by hour.
Using the “Picture Motion Browser” (supplied)

3 Displaying individual images

On the hour display screen, double-click a thumbnail to display the image by itself in a separate window.

- You can edit displayed images by clicking the toolbar button.

Displaying images in full-screen mode

To display a slide show of current images in full-screen mode, click the button.

- To play or pause the slide show, click the button on the lower left of the screen.
- To stop the slide show, click the button on the lower left of the screen.
**Creating a data disc**

Images can be saved in CD or DVD as a data disc.
• CD burner drive or DVD burner drive required.
• The following disc can be used for creating a data disc.
  – CD–R/RW (12 cm)
  – DVD±R/RW (12 cm)
  – DVD+R DL (12 cm)

1 **Select images to save on the disc.**

• To select consecutive images, click the first image, then press and hold down “Shift” key while you click the last image.
• To select two or more non-consecutive images, press and hold down “Ctrl” key while clicking images.

2 **Click the button on the tool bar.**

The [Create Data Disc] display appears.

3 **Click [Start].**

4 **Follow the display instructions to proceed with creating the data disc.**

• To add desired images, drag and drop on the [Create Data Disc] display.

**Selecting all images in a folder**

Click the [folders] tab, then right-click on the desired folder icon and select [Create Data Disc]. All images in a folder can be selected.

**Using Map View to display still images on a map**

If your still images have position information, you can see the images on maps online with Map View.
• To use the Map View function, your computer needs to be connected to the Internet.

1 **Select a thumbnail marked with .**

2 **Click .**

The Map View main window appears.

- Maps and satellite images powered by Google Maps mapping service.
- You can later add position information on the still images, using the Map View. For details, see the Help of Map View.
Using the “Picture Motion Browser” (supplied)

Other functions

Preparing images stored on the computer for viewing

To view them, register the folder that contains the images as one of the “Viewed folders”.

1. Click on the main screen, or choose [Register Folders to View] from the [File] menu.

The settings screen for “Viewed folders” registration is displayed.

2. Specify the folder with images for importing to register the folder as one of the “Viewed folders”.

3. Click [OK].

The image information is registered in the database.

- Images in any subfolders of “Viewed folders” are also registered.

Changing the “Folder to be imported”

To change the “Folder to be imported”, access the “Import Settings” screen.

1. Choose [Import Settings] → [Location for Imported Images] from the [File] menu.

The “Location for Imported Images” screen is displayed.

2. Choose the “Folder to be imported”.

- You can specify the “Folder to be imported” from folders registered as “Viewed folders.”

Updating image registration information

To update image information, choose [Update Database] from the [Tools] menu.

- Updating the database may take a while.
- If you rename image files or folders in “Viewed folders”, they cannot be displayed with this software. In this case, update the database.

Saving images with the date

1. Double-click an image to display it.

2. Click and select [Insert Date] from the drop-down list.

3. Select your desired color and position, and then click [OK].

4. Click to save.

Printing images with the date

1. Select the still image you want to print.

2. Click on the toolbar.

3. Click the check box of [Print date taken] in Print Options.

4. Click [Print].
To uninstall the “Picture Motion Browser”

1. Click [Start] → [Control Panel] (in Windows 2000, [Start] → [Settings] → [Control Panel]), then double-click [Add/Remove Programs].

2. Select [Sony Picture Utility], then click [Remove] (in Windows 2000, [Change/Remove]) to execute the uninstallation.
Using your Macintosh computer

You can copy images to your Macintosh computer.
- “Picture Motion Browser” is not compatible with Macintosh computers.

**Recommended computer environment**

The following environment is recommended for a computer connected to the camera.

**Recommended environment for copying images**

**OS (pre-installed):** Mac OS 9.1/9.2/ Mac OS X(v10.1 to v10.4)

**USB jack:** Provided as standard

**Notes on connecting your camera to a computer**

- Operations are not guaranteed for all the recommended computer environments mentioned above.
- If you connect two or more USB devices to a single computer at the same time, some devices, including your camera, may not operate depending on the types of USB devices you are using.
- Operations are not guaranteed when using a USB hub.
- There are two modes for a USB connection when connecting a computer, [Mass Storage] (default setting) and [PTP] modes. This section describes [Mass Storage] as an example. For details on [PTP], see page 53.
- When your computer resumes from the suspend or sleep mode, communication between your camera and your computer may not recover at the same time.

---

**Copying and viewing images on a computer**

1 **Prepare the camera and a Macintosh computer.**

   Perform the same procedure as described in “Stage 1: Preparing the camera and the computer” on page 60.

2 **Connect the dedicated USB cable.**

   Perform the same procedure as described in “Stage 2: Connecting the camera and your computer” on page 61.

3 **Copy image files to the Macintosh computer.**

   ① Double-click the newly recognized icon → [DCIM] → the folder where the images you want to copy are stored.
   ② Drag and drop the image files to the hard disk icon. The image files are copied to the hard disk.
   - For details on the storage location of the images and file names, see page 65.

4 **View images on the computer.**

   Double-click the hard disk icon → the desired image file in the folder containing the copied files to open that image file.
To delete the USB connection

Perform the procedures listed below beforehand when:

- Disconnecting the dedicated USB cable
- Removing a “Memory Stick Duo”
- Inserting a “Memory Stick Duo” into the camera after copying images from the internal memory
- Turning off the camera

Drag and drop the drive icon or the icon of the “Memory Stick Duo” to the “Trash” icon.

The camera is disconnected from the computer.

Technical Support

Additional information on this product and answers to frequently asked questions can be found at the Sony Customer Support Website.
http://www.sony.net/
When you print images shot in [16:9] mode, both edges may be cut off, so be sure to check before printing (page 90).

**Printing directly using a PictBridge compliant printer (page 77)**

You can print images by connecting the camera directly to a PictBridge compliant printer.

**Printing directly using a “Memory Stick” compliant printer**

You can print images with a “Memory Stick” compliant printer. For details, see the operating instructions supplied with the printer.

**Printing using a computer**

You can copy images to a computer using the supplied “Picture Motion Browser” software and print the images. You can print images date inserted (page 72).

**Printing at a shop (page 81)**

You can take a “Memory Stick Duo” containing images shot with your camera to a photo printing service shop. You can make a (Print order) mark on images which you want to print out in advance.
Printing images directly using a PictBridge compliant printer

Even if you do not have a computer, you can print images shot using your camera by connecting the camera directly to a PictBridge compliant printer.

PictBridge

- “PictBridge” is based on the CIPA standard.
  (CIPA: Camera & Imaging Products Association)

In single-image mode
You can print a single image on a printing sheet.

In index mode
You can print several images at a reduced size on a printing sheet. You can print a set of either the same images (①) or different images (②).

① ②

- An index print function may not be provided depending on the printer.
- The quantity of images that can be printed as an index image differ depending on the printer.
- You cannot print movies.
- If the indicator flashes on the screen of the camera for about five seconds (error notification), check the connected printer.

Stage 1: Preparing the camera

Prepare the camera to connect it to the printer with the dedicated USB cable.

1 Press MENU to display the menu.

2 Press on the control button to select (Setup).

3 Select [ ] (Setup2) with , then select [USB Connect] with ▲▼◆.

4 Select [PictBridge] with ◆▲, then press ○.

The USB mode is set.
**Stage 2: Connecting the camera to the printer**

1. Connect the camera to the printer.

   - To the USB jack
   - Dedicated USB cable

2. Turn on your camera and the printer.

   After the connection is made, the indicator appears.

The camera is set to playback mode, then an image and the print menu appear on the screen.

**Stage 3: Printing**

Regardless of what the mode dial is set to, the print menu appears when you complete Stage 2.

1. Select the desired printing method with ▲/▼ on the control button, then press ●.

   - **[All In This Folder]**
     Prints all the images in the folder.
   - **[DPOF image]**
     Prints all the images with a (Print order) mark (page 81) regardless of the displayed image.
   - **[Select]**
     Selects images and prints all the selected images.
       1. Select the image you want to print with ◀▶, then press ●.
          The mark appears on the selected image.
          • To select other images, repeat this procedure.
       2. Select [Print] with ▼, then press ●.
   - **[This image]**
     Prints a displayed image.
     • If you select [This image] and set [Index] to [On] in step 2, you can print a set of the same images as an index image.
2 Select print settings with ▲/▼/◄/►.

- [Index]
  Select [On] to print as an index image.

- [Size]
  Select the size of the printing sheet.

- [Date]
  Select [Day&Time] or [Date] to insert the date and time on images.
  - When you choose [Date], the date will be inserted in the order you select (page 54).
  - This function may not be provided depending on the printer.

- [Quantity]
  When [Index] is set to [Off]:
  Select the number of sheets of an image that you want to print. The image will be printed as a single image.
  When [Index] is set to [On]:
  Select the number of sets of images that you want to print as an index image. If you selected [This image] in step 1, select the number of the same image you want to print side by side on a sheet as an index image.
  - The designated number of images may not all fit onto a single sheet depending on the quantity of images.

3 Select [OK] with ▼/▲, then press ●.

The image is printed.
- Do not disconnect the dedicated USB cable while the ➡️ (PictBridge Connecting) indicator appears on the screen.

To print other images
After step 3, select [Select] and the desired image with ▲/▼, then perform from step 1.

To print images on the index screen
Perform “Stage 1: Preparing the camera” (page 77) and “Stage 2: Connecting the camera to the printer” (page 78), then proceed with the following.

When you connect the camera to a printer, the print menu appears. Select [Cancel] to turn off the print menu, then proceed as follows.

① Press ➡️ (Index).
   The index screen appears.

② Press MENU to display the menu.

③ Select [ ] (Print) with ►, then press ●.

④ Select the desired printing method with ▲/▼, then press ●.
[Select]
Selects images and prints all the selected images.
Select the image you want to print with ▲/▼/◅▻, then press ● to display the ✓ mark. (Repeat this procedure to select other images.) Then, press MENU.

[DPOF image]
Prints all the images with a 📸 (Print order) mark regardless of the displayed image.

[All In This Folder]
Prints all the images in the folder.

5 Perform steps 2 and 3 of “Stage 3: Printing” (page 78).
You can take a “Memory Stick Duo” containing images shot with your camera to a photo printing service shop. As long as the shop supports photo printing services conforming to the DPOF, you can make a (Print order) mark on images in advance so that you do not need to reselect them when you print them out at the shop.

- You cannot print images stored in the internal memory at a print shop directly from the camera. Copy the images to a “Memory Stick Duo”, then take the “Memory Stick Duo” to the print shop.

**What is DPOF?**

DPOF (Digital Print Order Format) is a function allowing you to make a (Print order) mark on images of “Memory Stick Duo” that you want to print out later.

- You can also print the images with the (Print order) mark using a printer that conforms to the DPOF (Digital Print Order Format) standard or using a PictBridge compliant printer.
- You cannot mark movies.

**When taking a “Memory Stick Duo” to a shop**

- Consult your photo printing service shop as to what types of “Memory Stick Duo” they handle.
- If a “Memory Stick Duo” is not handled by your photo printing service shop, copy the images you want to print out to other medium such as a CD-R and take it to the shop.
- Be sure to take the Memory Stick Duo Adaptor with it.
- Before you take image data to a shop, always copy (back up) your data to a disk.
- You cannot set the number of prints.
- When you want to superimpose dates on images, consult your photo printing service shop.

### Marking in single-image mode

**1** Display the image you want to print.

**2** Press MENU to display the menu.

**3** Select DPOF with ◄/►, then press ●.

A (Print order) mark is marked on the image.

**4** To mark other images, display the desired image with ◄/►, then press ●.

To remove the mark in single-image mode

Press ● in step 3 or 4.
Printing at a shop

Marking in index mode

1 Display the index screen (page 29).

2 Press MENU to display the menu.

3 Select DPOF with ←/→, then press ●.

4 Select [Select] with ▲/▼, then press ●.
   • You cannot add a  mark in [All In This Folder].

5 Select the image you want to mark with ▲/▼/←/→, then press ●.
   A green  mark appears on the selected image.

6 Repeat step 5 to mark other images.

7 Press MENU.

8 Select [OK] with ▶, then press ●.
   The  mark turns white.

To cancel, select [Cancel] in step 4 or select [Exit] in step 8, then press ●.

To remove the mark in index mode
Select the images from which you want to remove the mark in step 5, then press ●.

To remove all the marks in the folder
Select [All In This Folder] in step 4, then press ●. Select [Off], then press ●.
If you experience trouble with your camera, try the following solutions.

1. Check the items on pages 84 to 92.

2. Remove the batteries, and insert the batteries again after about one minute, and turn on the power.

3. Initialize the settings (page 52).

4. Consult your Sony dealer or local authorized Sony service facility.

Please understand that you give your consent that the contents of the internal memory may be checked when you send your camera to be repaired.

Click one of the following items to jump to the page explaining the symptom and cause or the appropriate corrective action.

<table>
<thead>
<tr>
<th>Batteries and power</th>
<th>84</th>
<th>“Memory Stick Duo”</th>
<th>90</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shooting still images/movies</td>
<td>85</td>
<td>Internal memory</td>
<td>90</td>
</tr>
<tr>
<td>Viewing images</td>
<td>87</td>
<td>Printing</td>
<td>90</td>
</tr>
<tr>
<td>Deleting/Editing images</td>
<td>87</td>
<td>PictBridge compliant printer</td>
<td>91</td>
</tr>
<tr>
<td>Computers</td>
<td>88</td>
<td>Others</td>
<td>92</td>
</tr>
<tr>
<td>Picture Motion Browser</td>
<td>89</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Batteries and power

The battery remaining indicator is incorrect, or sufficient battery remaining indicator is displayed but the power runs out too quickly.

- This phenomenon occurs when you use the camera in an extremely hot or cold location.
- When using alkaline batteries/Oxy Nickel Primary Battery (not supplied), the displayed time remaining may not be correctly indicated.
- The batteries are discharged. Install new batteries or charged Nickel-Metal Hydride batteries (not supplied).
- When using the Nickel-Metal Hydride batteries, the poles of batteries or the terminals of the battery cover are dirty so the batteries are not charged sufficiently. Clean them with a cotton swab, etc. (page 98).
- When using the Nickel-Metal Hydride batteries, the displayed time remaining differs from the current one due to the memory effect (page 98), etc. Fully discharge and then charge the batteries to correct the display.
- The batteries are dead. Replace them with new ones.

The batteries run down too quickly.

- You are using the camera in an extremely cold location.
- The batteries are dead. Replace them with new ones.
- When using the Nickel-Metal Hydride batteries, charge them sufficiently.

Camera power is turned off automatically when you open the battery/“Memory Stick Duo” cover.

- This is not a malfunction. Turn off the camera before you open the battery/“Memory Stick Duo” cover.

Cannot turn on the camera.

- Install the batteries correctly.
- Properly connect the AC Adaptor (not supplied).
- The batteries are discharged. Install new batteries or charged Nickel-Metal Hydride batteries.
- The batteries are dead. Replace them with new ones.

The power turns off suddenly.

- If you do not operate the camera for about three minutes while the power is on, the camera turns off automatically to prevent wearing down the batteries. Turn on the camera again.
- The batteries are discharged. Install new batteries or charged Nickel-Metal Hydride batteries.
Shooting still images/movies

Your camera cannot record images.
• Check the free capacity of the internal memory or “Memory Stick Duo”. If it is full, do one of the following:
  – Delete unnecessary images (page 28).
  – Change the “Memory Stick Duo”.
• You are using the “Memory Stick Duo” with the write-protect switch, and the switch is set to
  the LOCK position. Set the switch to the recording position (page 96).
• You cannot record images while charging the flash.
• Set the mode dial to , , , , , , , ,  when shooting still images.
• Set the mode dial to  when shooting movies.

The subject is not visible on the screen.
• Your camera is set to the Playback mode. Press  (Playback) to change to the recording
  mode (page 28).

The image is out of focus.
• The subject is too close. Shoot in  (Macro) recording mode. Make sure to position the lens
  farther away from the subject than the shortest shooting distance, approximately 5 cm (2
  inches) (W)/35 cm (13 7/8 inches) (T), when shooting (page 21).
•  (Twilight mode) or  (Landscape mode) is selected in the Scene mode when shooting still
  images.

Zoom does not work.
• The smart zoom cannot be used when image size is set to [7M] or [3:2].
• The digital zoom cannot be used while shooting movies.
• The zoom scale cannot be changed while shooting movies.

The flash does not work.
• The flash is set to  (Flash forced off) (page 21).
• You cannot use the flash when:
  – [Mode] (REC Mode) is set to [Burst] (page 37).
  –  (High sensitivity mode) or  (Twilight mode) is selected in the Scene mode (page 26).
    – Shooting movies.
• Set the flash to  (Flash forced on) when  (Landscape mode),  (Beach mode), or  (Snow mode)
  is selected in the Scene mode (page 21).

Fuzzy specks appear in images shot using the flash.
• Dust in the air reflected the flash light and appeared in the image. This is not a malfunction.
Troubleshooting

The close-up shoot function (Macro) does not work.
- (Twilight mode) or (Landscape mode) is selected in the Scene mode (page 27).

The date and time are not displayed.
- While shooting, the date and time are not displayed. They are displayed only during playback.

Cannot insert dates on images.
- This camera does not have a feature for superimposing dates on images (page 91). You can print or save images with the date inserted using “Picture Motion Browser” (page 72).

The F value and shutter speed flash when you press and hold the shutter button halfway down.
- The exposure is incorrect. Correct the exposure (page 23).

The screen is too dark or too bright.
- Adjust the brightness of the LCD backlight (pages 16, 52).

The image is too dark.
- You are shooting a subject with a light source behind the subject. Select the metering mode (page 33) or adjust the exposure (page 23).

The image is too bright.
- Adjust the exposure (page 23).

The image colors are not correct.
- Set [COLOR] (Color Mode) to [Normal] (page 32).

Vertical streaks appear when you are shooting a very bright subject.
- The smear phenomenon is occurring. This phenomenon is not a malfunction.

Noise appears in the image when you view the screen in a dark place.
- The camera is attempting to increase the visibility of the screen by temporarily brightening the image under conditions of low illumination. There is no effect on the recorded image.

The eyes of the subject come out red.
- Set [Red Eye Reduction] in the (Setup) menu to [On] (page 47).
- Shoot the subject at a distance closer than the flash range using the flash.
- Light the room and shoot the subject.
Dots appear and remain on the screen.
- This is not a malfunction. These dots are not recorded (page 2).

Cannot shoot images in succession.
- The internal memory or “Memory Stick Duo” is full. Delete unnecessary images (page 28).
- The battery level is low. Install new batteries or charged Nickel-Metal Hydride batteries (not supplied).

Viewing images

Your camera cannot play back images.
- Press (Playback) button (page 28).
- The folder/file name has been changed on your computer (page 67).
- When an image file has been processed by a computer or when the image file was recorded using a model other than that of your camera, playback on your camera is not guaranteed.
- The camera is in USB mode. Delete the USB connection (page 65).

The date and time are not displayed.
- DISP button is turned off (page 16).

The image appears rough right after playback starts.
- The image may appear rough right after playback starts due to image processing. This is not a malfunction.

The image does not appear on the TV screen.
- Check [Video Out] to see if the video output signal of your camera is set to the color system of your TV (page 54).
- Check whether the connection is correct (page 55).

Deleting/Editing images

Your camera cannot delete an image.
- Cancel the protection (page 41).
- You are using the “Memory Stick Duo” with the write-protect switch, and the switch is set to the LOCK position. Set the switch to the recording position (page 96).

You have deleted an image by mistake.
- Once you have deleted an image, you cannot restore it. We recommend that you protect images (page 40), or use the “Memory Stick Duo” with the write-protect switch and set the switch to the LOCK position (page 96) to prevent accidental erasure.
Troubleshooting

The resizing function does not work.

- You cannot resize movies.

Computers

You do not know if the OS of your computer is compatible with the camera.

- Check “Recommended computer environment” on page 58 for Windows, and page 74 for Macintosh.

“Memory Stick PRO Duo” is not recognized by a computer with a “Memory Stick” slot.

- Check that the computer and the Memory Stick Reader/Writer support “Memory Stick PRO Duo”. Users of computers and Memory Stick Readers/Writers made by manufacturers other than Sony should contact those manufacturers.
- If “Memory Stick PRO Duo” is not supported, connect the camera to the computer (pages 61 and 74). The computer recognizes the “Memory Stick PRO Duo”.

Your computer does not recognize your camera.

- Turn on the camera.
- When the battery level is low, install new batteries or charged Nickel-Metal Hydride batteries (not supplied), or use the AC Adaptor (not supplied).
- Use the dedicated USB cable (supplied) (page 61).
- Disconnect the dedicated USB cable from both the computer and the camera, and connect it again firmly.
- Disconnect all equipment other than the camera, the keyboard and the mouse from the USB connectors of your computer.
- Connect the camera directly to your computer without passing through a USB hub or other device (page 61).

You cannot copy images.

- Connect the camera and your computer correctly making a USB connection (page 61).
- Follow the designated copy procedure for your OS (pages 61 and 74).
- When you shoot images with a “Memory Stick Duo” formatted by a computer, you may not be able to copy the images to a computer. Shoot using a “Memory Stick Duo” formatted by your camera (page 49).

After making a USB connection, “Picture Motion Browser” does not start automatically.

- Start “Media Check Tool” (page 68).
- Make the USB connection after the computer is turned on (page 61).
Troubleshooting

The image cannot be played back on a computer.
- If you are using “Picture Motion Browser,” refer to the Help.
- Consult the computer or software manufacturer.

The image and sound are interrupted by noise when you view a movie on a computer.
- You are playing back the movie directly from the internal memory or the “Memory Stick Duo”. Copy the movie to the hard disk of your computer, then play back the movie from the hard disk (page 60).

You cannot print an image.
- Refer to the operation manual of the printer.

Images once copied to a computer cannot be viewed on the camera.
- Copy them to a folder recognized by the camera, such as “101MSDCF” (page 65).
- Operate correctly (page 67).

**Picture Motion Browser**

Images are not displayed correctly with “Picture Motion Browser”.
- Make sure the folder of the images is registered in “Viewed folders”. If the images are not displayed even if the folder is registered in “Viewed folders”, update the database (page 72).

You cannot find images imported with “Picture Motion Browser”.
- Look in the “My Pictures” folder.
- If you have changed the default settings, refer to “Changing the “Folder to be imported” on page 72 and check what folder is used for importing.

You want to change the “Folder to be imported”.
- Access the “Import Settings” screen to change “Folder to be imported”. You can specify a different folder after using “Picture Motion Browser” to register it in “Viewed folders” (page 72).

All imported images are displayed on the calendar with the date January 1.
- The date has not been set on the camera. Set the date on the camera (page 54).

The 🔄 mark appears.
- If you have renamed or deleted image files/folders in other software, the image registration information is not updated. Select [Update Database] from the [Tools] menu to update image registration information.
Troubleshooting

“Memory Stick Duo”

Cannot insert a “Memory Stick Duo”.
  • Insert it in the correct direction.

Cannot format a “Memory Stick Duo”.
  • You are using the “Memory Stick Duo” with the write-protect switch, and the switch is set to the LOCK position. Set the switch to the recording position (page 96).

You have formatted a “Memory Stick Duo” by mistake.
  • All the data on the “Memory Stick Duo” is deleted by formatting. You cannot restore it. We recommend that you set the write-protect switch on the “Memory Stick Duo” to the LOCK position to prevent accidental erasure (page 96).

Internal memory

Cannot play back or record images using the internal memory.
  • There is a “Memory Stick Duo” inserted in the camera. Remove it.

Cannot copy the data stored in the internal memory to a “Memory Stick Duo”.
  • The “Memory Stick Duo” is full. Check the capacity (32 MB or more recommended).

Cannot copy the data on the “Memory Stick Duo” or the computer to the internal memory.
  • Data on a “Memory Stick Duo” or a computer cannot be copied to the internal memory.

Printing

Also see “PictBridge compliant printer” (as follows) in conjunction with the following items.

Images are printed with both edges cut off.
  • Depending on your printer, the left, right, top, and bottom edges of the image may be cut off. Especially when you print an image shot with the image size set to [16:9], the edge of the image may be cut off.
  • When printing images using your own printer, try canceling the trimming or borderless settings. Consult the printer manufacturer as to whether the printer provides these functions or not.
  • When having images printed at a digital print shop, ask the shop whether they can print the images without cutting off both edges.
Troubleshooting

**Cannot print images with the date inserted.**
- You can print images with the date inserted using “Picture Motion Browser” (page 72).
- This camera does not have a feature for superimposing dates on images. However, because the images shot with the camera include information on the recording date, you can print images with the date superimposed if the printer or the software can recognize Exif information. For compatibility with Exif information, consult the manufacturer of the printer or the software.
- When you print images at a shop, images can be printed with the date inserted if you ask them to do so.

**PictBridge compliant printer**

**A connection cannot be established.**
- The camera cannot be connected directly to a printer that is not compliant with the PictBridge standard. Consult the printer manufacturer as to whether the printer is compliant with PictBridge or not.
- Check that the printer is turned on and can be connected to the camera.
- Set [USB Connect] to [PictBridge] in the (Setup) menu (page 53).
- Disconnect and connect the dedicated USB cable again. If an error message is indicated on the printer, refer to the operating instructions supplied with the printer.

**Cannot print images.**
- Check that the camera and the printer are properly connected using the dedicated USB cable.
- Turn on the printer. For further information, refer to the operating instructions supplied with the printer.
- If you select [Exit] during printing, images may not be printed. Disconnect and connect the dedicated USB cable again. If you still cannot print your images, disconnect the dedicated USB cable, turn the printer off and then on, then connect the dedicated USB cable again.
- Movies cannot be printed.
- Images shot using cameras other than this camera or images modified with a computer may not be printed.

**Printing is canceled.**
- You disconnected the dedicated USB cable before the (PictBridge Connecting) mark disappears.

**Cannot insert the date or print images in the index mode.**
- The printer does not provide these functions. Consult the printer manufacturer as to whether the printer provides these functions or not.
- The date may not be inserted in the index mode depending on the printer. Consult the printer manufacturer.

“----- -- --” is printed on the date-inserted part of the image.
- Images that do not have the recording data cannot be printed with the date inserted. Set [Date] to [Off] and print the image again (page 79).
Troubleshooting

Cannot select the print size.
• Consult the printer manufacturer as to whether the printer can provide the desired size.

Cannot print the image at the size selected.
• Disconnect the dedicated USB cable and reconnect it whenever you change the paper size after the printer has been connected to the camera.
• The print setting of the camera differs from that of the printer. Change the setting of either the camera (page 79) or the printer.

Cannot operate the camera after canceling printing.
• Wait for a while as the printer is carrying out the cancellation. It may take some time depending on the printer.

Others

The camera does not function with the lens portion extended.
• Do not attempt to force the lens that has stopped moving.
• Insert new batteries or charged Nickel-Metal Hydride batteries, then turn on the camera again.

The lens gets fogged.
• Moisture condensation has occurred. Turn off the camera and leave it for about an hour before using it.

The camera becomes warm when you use it for a long time.
• This is not a malfunction.

The lens does not move when you turn off the camera.
• The batteries are discharged. Install new batteries or charged Nickel-Metal Hydride batteries or use the AC Adaptor (not supplied).

The Clock Set screen appears when you turn on the camera.
• Set the date and time again (page 54).

You want to change the date or time.
• Set the date and time again (page 54).
Warning messages

If the following messages appear, follow the instructions.

- The battery level is low. Install new ones or charged Nickel-Metal Hydride batteries (not supplied). Depending on the conditions of use or the type of battery, the indicator may flash even though there are still 5 to 10 minutes of remaining battery time left.

System error
- Turn the power off and then on again.

Internal memory error
- Turn the power off and then on again.

Reinsert the Memory Stick
- Insert the “Memory Stick Duo” correctly.
- The inserted “Memory Stick Duo” cannot be used in your camera (page 96).
- The “Memory Stick Duo” is damaged.
- The terminal section of the “Memory Stick Duo” is dirty.

Memory Stick type error
- The inserted “Memory Stick Duo” cannot be used in your camera (page 96).

Format error
- Format the media again (pages 48 and 49).

Memory Stick locked
- You are using the “Memory Stick Duo” with the write-protect switch, and the switch is set to the LOCK position. Set the switch to the recording position (page 96).

No memory space in internal memory

No file in this folder
- No images that can be played have been recorded in this folder.
- You did not operate correctly when copying images from your computer (page 67).

Folder error
- A folder with the same first three digit number already exists on the “Memory Stick Duo” (for example: 123MSDCF and 123ABCDE). Select another folders, or create a new folder (pages 49, 50).

Cannot create more folders
- The folder with a name beginning with “999” exists on the “Memory Stick Duo”. You cannot create any folders if this is the case.

No file
- No images that can be played have been recorded in the internal memory.

Read only memory
- Your camera cannot record or delete images on this “Memory Stick Duo”.

No memory space in Memory Stick
- Delete unnecessary images or files (page 28).

No file
- No images that can be played have been recorded in the internal memory.
Warning messages

**Cannot record**
- The camera cannot record images in the selected folder. Select a different folder (page 50).

**File error**
- An error occurred while the image was playing back.

**File protect**
- Release the protection (page 41).

**Image size over**
- You are playing back an image of a size that cannot be played back on your camera.

**Invalid operation**
- You are trying to play back a file that is not compatible with the camera.

⚠️ **(Vibration warning indicator)**
- Camera shake may occur due to insufficient light. Use the flash or mount the camera on a tripod to secure the camera.

**Enable printer to connect**
- [USB Connect] is set to [PictBridge], however the camera is connected to a non-PictBridge compliant device. Check the device.
- The connection is not established. Disconnect and connect the dedicated USB cable again. If an error message is indicated on the printer, refer to the operating instructions supplied with the printer.

**Connect to PictBridge device**
- You tried to print images before the printer connection was established. Connect to a PictBridge compliant printer.

**No printable image**
- You tried to execute [DPOF image] without placing a DPOF (Print order) mark on the image(s).
- You tried to execute [All In This Folder] while a folder that holds only movies was selected. You cannot print movies.

**Printer busy**

**Paper error**
- No Paper
- Ink error
- Low Ink
- No Ink
  - Check the printer.

**Printer error**
- Check the printer.
- Check if the image you want to print is corrupted.

⚠️
- The data transmission to the printer may not be completed yet. Do not disconnect the dedicated USB cable.

**Processing**
- The printer is canceling the current print job. You cannot print until it is finished. This may take time, depending on the printer.
To use your camera abroad — Power sources

You can use your camera, the AC-LS5K AC Adaptor (not supplied) in any country or region where the power supply is within 100 V to 240 V AC, 50/60 Hz.

- Do not use an electronic transformer (travel converter), as this may cause a malfunction.
A “Memory Stick” is a compact, portable IC recording medium. The types of “Memory Stick” that can be used with this camera are listed in the table below. However, proper operation cannot be guaranteed for all “Memory Stick” functions.

### Notes on using a “Memory Stick Duo” (not supplied)
- You cannot record, edit or delete images if you slide the write-protect switch to LOCK with a fine-tipped object.
- Supports high-speed data transfer using a parallel interface.
- This product is compatible with “Memory Stick Micro” (“M2”). “M2” is the abbreviation for the “Memory Stick Micro.”
- A “Memory Stick Duo” formatted with a computer is not guaranteed to operate with this camera.
- Data read/write speeds differ depending on the combination of the “Memory Stick Duo” and the equipment used.
- Supports high-speed data transfer using a parallel interface.
- Do not press down hard when you write down on the memo area.
- Do not attach a label on the “Memory Stick Duo” itself nor on a Memory Stick Duo Adaptor.
- Do not strike, bend or drop the “Memory Stick Duo”.
- Do not disassemble or modify the “Memory Stick Duo”.
- Do not expose the “Memory Stick Duo” to water.
- Do not leave the “Memory Stick Duo” within the reach of small children. They might accidentally swallow it.

### “Memory Stick” type

<table>
<thead>
<tr>
<th>“Memory Stick” type</th>
<th>Recording/Playback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory Stick (without MagicGate)</td>
<td>—</td>
</tr>
<tr>
<td>Memory Stick (with MagicGate)</td>
<td>—</td>
</tr>
<tr>
<td>Memory Stick Duo (without MagicGate)</td>
<td>○</td>
</tr>
<tr>
<td>Memory Stick Duo (with MagicGate)</td>
<td>○<em>1</em>2</td>
</tr>
<tr>
<td>MagicGate Memory Stick</td>
<td>—</td>
</tr>
<tr>
<td>MagicGate Memory Stick Duo</td>
<td>○<em>1</em>2</td>
</tr>
<tr>
<td>Memory Stick PRO</td>
<td>—</td>
</tr>
<tr>
<td>Memory Stick PRO Duo</td>
<td>○<em>1</em>2</td>
</tr>
</tbody>
</table>

*1 “Memory Stick Duo”, “MagicGate Memory Stick Duo” and “Memory Stick PRO Duo” are equipped with MagicGate functions. MagicGate is copyright protection technology that uses encryption technology. Data recording/playback that requires MagicGate functions cannot be performed with this camera.

*2 Supports high-speed data transfer using a parallel interface.

Some “Memory Stick Duo” cards do not have a write-protect switch. The position and/or the shape of the write-protect switch may differ depending on the “Memory Stick Duo” you use.

- Do not remove the “Memory Stick Duo” while reading or writing data.
- Data may be corrupted in the following cases:
  - When the “Memory Stick Duo” is removed or the camera is turned off during a read or write operation
  - When the “Memory Stick Duo” is used in locations subject to static electricity or electrical noise
- We recommend backing up important data.
- Do not disassemble or modify the “Memory Stick Duo”.
- Do not expose the “Memory Stick Duo” to water.
- Do not leave the “Memory Stick Duo” within the reach of small children. They might accidentally swallow it.
On the “Memory Stick”

- Do not use or store the “Memory Stick Duo” under the following conditions:
  - High temperature locations such as the hot interior of a car parked in direct sunlight
  - Locations exposed to direct sunlight
  - Humid locations or locations with corrosive substances present

Notes on using the Memory Stick Duo Adaptor (not supplied)

- To use a “Memory Stick Duo” with a “Memory Stick” compliant device, be sure to insert the “Memory Stick Duo” into a Memory Stick Duo Adaptor. If you insert a “Memory Stick Duo” into a “Memory Stick” compliant device without a Memory Stick Duo Adaptor, you might not be able to remove it from the device.
- When inserting a “Memory Stick Duo” into a Memory Stick Duo Adaptor, make sure the “Memory Stick Duo” is inserted facing in the correct direction, then insert it all the way in. Incorrect insertion may result in a malfunction.
- When using a “Memory Stick Duo” inserted into a Memory Stick Duo Adaptor with a “Memory Stick” compliant device, make sure that the Memory Stick Duo Adaptor is inserted facing the correct direction. Note that improper use may damage the equipment.
- Do not insert a Memory Stick Duo Adaptor into a “Memory Stick” compliant device without a “Memory Stick Duo” attached. Doing so may result in malfunction of the unit.

Notes on using “Memory Stick PRO Duo” (not supplied)

“Memory Stick PRO Duo” with a capacity up to 4 GB have been confirmed to operate properly with this camera.

Notes on using “Memory Stick Micro” (not supplied)

- To use a “Memory Stick Micro” with this camera, you need a Duo-sized M2 Adaptor. Insert the “Memory Stick Micro” into the Duo-sized M2 Adaptor, and then insert the adaptor into the Memory Stick Duo slot. If you insert a “Memory Stick Micro” into this camera without using a Duo-sized M2 Adaptor, you might not be able to remove it from the camera.
- Do not leave the “Memory Stick Micro” within the reach of small children. They might accidentally swallow it.

- Do not leave the “Memory Stick Micro” within the reach of small children. They might accidentally swallow it.
On the batteries

Batteries you can and cannot use with your camera

<table>
<thead>
<tr>
<th>Battery type</th>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>LR6 (size AA) alkaline batteries*1</td>
<td>○</td>
<td>○</td>
<td>—</td>
</tr>
<tr>
<td>HR 15/51:HR6 (size AA) Nickel-Metal Hydride batteries<em>1</em>2</td>
<td>—</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>ZR6 (size AA) Oxy Nickel Primary Battery*1</td>
<td>—</td>
<td>○</td>
<td>—</td>
</tr>
<tr>
<td>Lithium batteries</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Manganese batteries</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Ni-Cd batteries</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
</tbody>
</table>

A: supplied  
B: supported  
C: rechargeable  

*1 Before using batteries, read the following precaution for each type of battery.  
*2 NH-AA-2DB twin pack, etc.

As for unsupported batteries, operating performance cannot be ensured if voltage drops or other problems are caused by the nature of the battery.

On alkaline batteries (supplied)/Oxy Nickel Primary Battery (not supplied)

- Alkaline batteries/Oxy Nickel Primary Battery cannot be charged.
- Alkaline batteries/Oxy Nickel Primary Battery have a shorter life compared to the Nickel-Metal Hydride batteries. For this reason, the power may turn off even though the battery remaining indicator shows sufficient battery life remaining.
- Battery performance differs greatly depending on the manufacturer and the type of battery, and in some cases the battery life may be extremely short. This is especially true at low temperatures, and you may not be able to shoot at temperatures below 5°C (41°F).
- Do not mix new and old batteries.
- The battery remaining indicator may not display the correct information when using alkaline batteries/Oxy Nickel Primary Battery.

- Due to characteristics of alkaline batteries/Oxy Nickel Primary Battery, there is a large difference between the available shooting time and the available playback time. For this reason, the camera may turn off with the lens portion extended when you switch the mode dial. In this case, replace the batteries with new ones. Using the Nickel-Metal Hydride batteries allows you to shoot for longer periods of time.

On Nickel-Metal Hydride batteries (not supplied)

- Do not peel off the external seals or damage the batteries. Never use batteries from which the seals have been partially or completely removed, or batteries that have been split in any way. These may cause leakage, explosion, or heat-up of the battery, and personal scald or injury may be caused. These may cause a malfunction of the battery charger.
- Do not carry or store the Nickel-Metal Hydride batteries with metallic objects. Since metallic objects may short the + and – ends, resulting in the risk of heating or fire.
- If the poles of the Nickel-Metal Hydride batteries are dirty, the batteries may not charge properly. Wipe them with a dry cloth, etc.
- At the time of purchase, or when the Nickel-Metal Hydride batteries have not been used for a long time, they may not full charge. This is typical of this type of battery, and is not a malfunction. If this happens, repeatedly using up the batteries fully, and then recharging them should correct the problem.
- If you recharge Nickel-Metal Hydride batteries before fully using up the existing charge, the low battery warning may be displayed sooner than expected. This is called the “memory effect.”* If this problem occurs, charging the batteries only after using up the existing charge will correct it.
  * The “memory effect” - the situation in which the capacity of the battery is temporarily lowered.
- To use up the batteries completely, put the camera in the slide show mode (page 42) and leave it that way until the batteries are used up.
- Do not mix new and used batteries.
- Do not expose the battery to water. The battery is not water-resistant.
A
AC Adaptor...........................11
Adjusting EV ........................23
AE/AF lock indicator............19
AF lock .................................19
AF range finder frame ..........19
Aperture ..............................7
Auto adjustment mode.........19
Auto Focus.........................6
Auto Review ......................47
AVI.....................................66

B
B&W.....................................32
Battery ..............................98
Beach mode ..........................26
Beep ......................................52
Blur .........................................6
Burst......................................37

C
Camera..................................46
CD-ROM ..................................59
Change REC. Folder.............50
Clock Set...............................54
Cloudy ...................................34
Color .......................................8
Color Mode...........................32
Compression ratio...............9
Computer .................57
Copying images...........60, 74
Macintosh ......................74
Recommended environment ......58, 74
Software .....................59
Viewing image files stored on a computer with your camera ....67
Windows .......................57

Connecting
Computer ..........................61
Printer ..................................78
TV .......................................55
Copy .................................51
Copying images to your computer ..........60
Create REC. Folder ..........49

D
Date ......................................54
Daylight................................ 35
Dedicated A/V cable ............55
Dedicated USB cable ....61, 78
Delete ...................................28
Format ...................................48, 49
Digital Zoom .........................46
DirectX ................................58
DPOF ...................................81

E
EV ........................................ 23
Exposure ...................................7
Extension ...............................67

F
File name ..............................65
File Number ..........................53
File storage destination ......65
Fine ......................................36
Flash ....................................34
Flash forced off .................21
Flash forced on ..................21
Flash Level .........................38
Flash mode .........................21
Fluorescent .........................34
Focus .................................6
Folder ..................................39
Changing ..........................50
Creating ............................49

Format....................................48, 49
Function Guide .....................47

H
High Sensitivity mode ..........26
Holding the camera.............6, 19

I
Identifying parts ..................10
Image file storage destinations and file names ........65
Image quality .................9, 36
Image size .................9, 24
Incandescent ..................34
Index mode printing ..........77
Index screen .......................29
Indicator ..........................52
Install .................................59
Internal memory .............17
Internal Memory Tool .........48
ISO .....................................7, 35

J
JPG .......................................66

L
Landscape mode ..................26
Language ..............................52
LCD Backlight .........................52
LCD Screen .........................16

M
Macintosh computer ..........74
Macintosh Recommended environment ....74
Macro ...................................21
Map View ..............................71
Mass Storage .......................53
“Memory Stick Duo” ....96
Memory Stick Tool ........49
Index

Menu........................................30
  Items ..................................31
  Shooting ................................32
  Viewing ....................................39
Metering Mode ......................33
Mode .........................................37
Multi-pattern metering ..........33

N
  Natural ........................................32
  NTSC ...........................................54

O
  Optical zoom .........................20, 46
  OS ........................................58, 74
  Overexposure ...............................7

P
  P.Quality ................................36
  PAL ........................................54
  PC ........................................57
  PictBridge .........................53, 77
  Picture Motion Browser ..........68
  Pixel ........................................9
  Playback .....................................28
  Playback zoom .........................28
  Precision digital zoom .............46
  Pressing halfway down ..........6
  Print ........................................76
    Index mode ..............................77
    Single-image mode .................77
  Print order mark ......................81
  Printing at a shop ....................81
  Printing directly .....................77
  Program Auto mode .................18
  Protect .......................................40
  PTP ........................................53

R
  REC Mode ..................................37
  Red Eye Reduction ....................47
  Resize .....................................43
  Rewind/Fast forward ..............28
  Rich ........................................32
  Rotate .....................................44

S
  Scene Selection ..........................25
  Screen
    Changing the display ............16
    Indicator .........................12
    LCD backlight ....................16
  Self-timer ................................22
  Sepia ......................................32
  Setup ...............................38, 44, 45
    Camera ..................................46
    Internal Memory Tool ...........48
    Memory Stick Tool ...............49
    Setup 1 .............................52
    Setup 2 .............................53
  Setup 1 ................................52
  Setup 2 ................................53
  Sharpness ................................38
  Shooting
    Movie ..................................19
    Still image ..............................19
  Shooting menu .................32
  Shooting movies .................18
  Shutter speed .......................7
  Single-image mode printing ....77
  Slide Show ..............................42
  Slow synchro ..........................21
  Smart zoom ............................46
  Snow mode ................................26
  Soft Snap mode .......................26
  Software ................................59, 68
  Spot metering .........................33
  Spot metering cross hairs ....33
  Standard ..................................36

T
  Troubleshooting ........................83
  TV ...........................................55
  Twilight mode .........................26
  Twilight Portrait mode ............26

U
  Underexposure .........................7
  USB Connect .............................53
  USB-A/V OUT terminal ..........10

V
  VGA ........................................24
  Video Out ...............................54
  Viewing menu .........................39

W
  Warning messages ....................93
  WB .........................................34
  White balance ............................34
  Windows computer .................57
    Recommended environment ........58
    Write-protect switch ..........96

Z
  Zoom ........................................20
Additional information on this product and answers to frequently asked questions can be found at our Customer Support Website.

http://www.sony.net/